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Regularly make Backups!

PLEASE MAKE REGULAR BACKUPS OF YOUR PHONE BOOKS!    The information you keep in 
METZ Phones is very important and would be difficult to reproduce if lost.    Because hardware, 
networks, or applications may fail, or files can be accidentally deleted, we cannot guarantee that your data
is always 100% safe.    Fortunately, there are several ways you can easily backup your information for 
safekeeping.

 - Use third party backup software to store your information on tape or disk.    Be sure to backup the 
phone book file and subdirectory.    I.E. METZPHO.DB will have a corresponding METZPHO 
subdirectory with several files in it.    The subdirectory is where most of the information is stored.    METZ
Phones should be closed when you run third party backup software.

 - Use the METZ Phones Backup command.    This command creates a single file containing all of the 
information in the phone book, using less space than the existing phone book.    The file can be copied to a
floppy disk for safekeeping.    Use the File Restore command to load one of these files.

Your backup information should be stored off site for additional safety.

We do have some data recovery tools in case one or more of your tables are somehow corrupted, but we 
cannot guarantee that total recovery is always possible.



Using Phones on a network

Sharing phone books:
When setting up METZ Phones on a network to share phone books among users, the most important 
settings are the username and Paradox Control File directory in the File Preferences dialog.
The username helps identify who has a particular record locked when more than one user attempts to edit 
the same record.
The Control File directory is where the database engine keeps track of the users and what phone books 
they have open.    The directory setting must point to the same directory on the network for each user.    
I.E. if F:\METZPHO is the directory you want the control file to be stored in, each users Control File 
directory must be set to F:\METZPHO in the File Preferences dialog.    The actual control file 
(PDOXUSRS.NET) is created and maintained automatically by the engine (even if deleted).

Running METZ Phones from a network:
METZ Phones can be installed to and run from a network directory, however performance may be best 
when installed on the individual workstations.    This depends mostly on your network speed.
If you wish to run METZ Phones from the network, the files Phones installs into your WINDOWS\
SYSTEM directory (except CTL3DV2.DLL) need to be copied to the installation directory.    Please 
contact us if you have any questions.



Using Phones with your Word Processor

It is easy to transfer information from METZ Phones into other applications such as a word processor.    
You can use the clipboard functions to copy and paste information from individual fields, or use the Edit 
Copy Addresses command, or you can save steps by using the hotkey options available in METZ Phones.

Use the Edit Hotkey and Clipboard layouts command to create filters for different sets of information you
typically need for your word processing.    These filters are used by both the Edit Copy Address(es) and 
Paste hotkey commands.

When you choose the Edit Copy Address(es) command, if you have more than one filter defined, you will
be given the opportunity to select a filter before the information is copied to the clipboard.    Once this has
been done, you can manually paste the information into your application.

Use the Paste hotkey to simplify the transfer of information into your application.      From your word 
processor, for example, all you need to do is press the hotkey combination (CTRL+ALT+P is the default),
and Phones will let you choose which filter and records to use, and do the rest for you, automatically!

You can also dial telephone numbers directly from other Windows applications using the Dial Hotkey 
(CTRL+ALT+D is the default).    Simply select the telephone number you wish to dial, then press the 
hotkey combination.

The File Preferences dialog allows you to define or change the hotkey settings.    Press the Help button in 
that dialog for more information.

This version of Phones includes a mail merge macro for Microsoft Word 6.0, which will automate 
processing and printing your form letters using information from your phone book.    Please follow the 
directions in METZMERG.DOC for installing and using this macro.    We plan to release macro's for 
other popular word processors.    Please contact us for more information.



Copying Records Between Phone Books

Copying records between Phone Books is a handy feature and its easy to do.    If you want to copy a small
group of records, about 100 records or less, use the Copy Record(s) and Paste Record(s).    First select the 
records that you want to copy.    Then choose Copy Record(s) from the List menu.    Now open the Phone 
Book that you want to copy the records to and choose the Paste Record(s) from the List menu.    Its that 
simple.

For larger groups of records use the Backup and Restore.    Select the group that you want to copy then 
choose Backup from the File menu.    In the resulting dialog box enter a file name and click the radio 
button that says Selections.    Click OK and the selected records will be copied to a backup file.    Now 
open the Phone Book that you want to copy the records to and choose Restore from the File menu.    Pick 
the backup file that you just created as the filename.    From the resulting dialog box choose how you want
the records to be copied (restored) and click OK.



Rebuilding the database indexes

METZ Phones allows you to sort your phone book in a variety of ways.    In order to improve 
performance, additional files called indexes are maintained.    If you periodically rebuild the indexes using
the File Rebuild Indexes command, you will improve performance and reduce the amount of disk space 
used.
You can specify only the indexes you need, be sure to include all the indexes that other users on the 
network may need.



Faster phone dialing

Depending on your modem, you can increase the dialing speed by adding S11=55 to the modem 
initialization setting in the Dial Modem Settings dialog.    Some modems do not support this option, 
remove this setting if your dialing does not work.



How to format telephone numbers

In order for Phones to detect the country code within a telephone number, the country code must begin 
with a plus sign "+" or be enclosed in square brackets [ ].    For example if your current country code 
settings is 1 (USA) and the telephone number to be dialed is entered as +1 (206) 641-4525, the +1 will be 
ignored when the number is dialed.
Put the area code in parenthesis ( ) when you are entering telephone numbers to help insure that Phones 
will detect it.    For example: (206) 641-4525.



System Resources

You can run METZ Phones all the time with only minimal demands on your system resources.    On 
average METZ Phones uses less than half the resources of most other PIM products, plus when 
minimized into an icon, it returns most of its resources to the system.    Thanks to this smart approach its 
much easier to keep your address book at your fingertips while large applications are running.    Keep 
METZ Phones available at all times for speedy access to your address books.
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Welcome to METZ Phones

Welcome to METZ Phones.    This guide will lead you through the powerful address and 
telephone management features METZ Phones provides to those connected to networks and 
individual users.

Network and workgroup users will appreciate the support for multiple users and concurrent users
that allows immediate networkwide access to updated data.    METZ Phones also provides 
complete compatibility with the Microsoft® Office™ suite of applications for the transparent 
sharing of information.    System administrators will appreciate that it works with all major 
networks and frees workstation resources when minimized.

Network, workgroup and individual users will all appreciate the flexibility and power of the List 
and Sort options available to them.    Importing from and exporting to most popular database 
programs is simple in METZ Phones.

Sharing information between address books and different users is what METZ Phones is all 
about. Users on and off networks have the same powerful choices for managing data.    Enter 
your records in the manner you prefer.    Keep separate address books for work and personal 
information.    Store as many phone numbers or multiple addresses as each entry requires.    Place
entries in as many different phone books as you like.    Sort your data to any of a wide variety 
choices, and then do subsequent sorts to further pinpoint what youre searching for.



METZ Phones System Requirements

To run METZ Phones, you need:
· MS-DOS operating system version 3.0 or later.
· Microsoft Windows operating system version 3.1 or later.
· Personal computer using 386 or higher microprocessor.
· Hard disk space required:

minimum installation: 1.7MB
full installation: 2.7MB

METZ Phones works with Novell Netware, Banyan Vines, IBM PC LAN, 3Com 3+ Share, 
DEC Pathworks, Microsoft LAN Manager, Windows for Workgroups, and any network that is 
100% compatible with one of these networks.



METZ Software Technical and Customer Support

Before you contact us, please check the Trouble Shooting section of this help file for possible 
answers to your questions.    Also, each of the METZ Phones dialogs have Help buttons which 
will display the online help section for the dialog.

How to contact METZ Software.    Includes addresses, phone and fax numbers, CompuServe and 
America Online access, bulletin board system access, and the Internet access.

There are several ways to obtain technical support for your METZ products (see address and 
telephone numbers at the end of this document).    Be sure to include the product name and 
version number.

1. CALL THE BBS number and log on to METZ's electronic bulletin board service to view and 
download information, updates and trial products.    You will need a modem and communication 
software.    Access the METZ BBS at up to 14400 bps, No parity, 8 data bits, 1 stop bit (N-8-1).

On the BBS, you may leave a message as a comment to the SYSOP for technical support, 
explaining your question in detail.

2. CALL COMPUSERVE to view and download information, updates and trial products.    You 
will need a modem, communication software, and a CompuServe membership.    GO METZ at 
any ! prompt.

On CompuServe, you may send a message to 75300,1627 for technical support.    A response will
be posted back to you within one business day.

If you are not a member of CompuServe, as a METZ customer you are entitled to a free 
introductory membership.    Simply call one of these CompuServe numbers:

CompuServe in USA & Canada (800) 524-3388
CompuServe Outside USA, Canada, & Europe (614) 529-1349
CompuServe in United Kingdom 0800.289.378
CompuServe in Germany 0130.37.32
Compuserve in Other European Countries +44 (89)66.55.0.111

3. CALL America Online to view and download information, updates and trial products.    You 
will need a modem, communication software, and a membership.    Use the GoTo Keyword 
METZ from the menu.

On AOL, you may send a message to METZSoft for technical support. A response will be posted
back to you within one business day.

If you are not a member of America Online, as a METZ customer you are entitled to a free 



introductory membership.    Simply call one of these America Online numbers and ask for a trial 
membership:

America Online (800) 827-6364
America Online FAX (800) 827-4595

4. SEND E-MAIL via the Internet to:    75300,1627@compuserve.com.    We are in the process 
of setting up an ftp site at metz.com.

5. SEND A FAX to the facsimile number explaining your question in detail.    Give your 
company name and both your phone and fax numbers in your message (with country and city 
codes).

6. CALL THE METZ SUPPORT LINE.

Sign up now to receive information about METZ Beta releases and/or our electronic 
newsletter!    If you are interested in receiving the METZ Electronic Newsletter, sign up for the 
METZNEWS program.    If you would like to participate in beta testing products, sign up for the 
METZBETA program instead.

Subscribing to METZNEWS is simple, send e-mail to 75300,1627 on Compuserve, 
METZSoft on AOL, or 75300,1627@compuserve.com from Internet sites.    Be sure to use 
SUBSCRIBE METZNEWS as the text of the message.

If you wish to subscribe to METZBETA, send e-mail to 75300,1627 on Compuserve, 
METZSoft on AOL, or 75300,1627@compuserve.com from Internet sites, and use SUBSCRIBE
METZBETA as the text of the message.

METZBETA subscribers will automatically receive mailings sent to METZNEWS 
subscribers so it is not necessary to subscribe to both groups.

METZ Software, Inc. Sales and Support TEL: (206) 641-4525
P.O. Box 6699 Sales TEL: (800) 447-1712
Bellevue, WA 98008-0699

24-Hr Fax TEL: (206) 644-6026
24-Hr BBS TEL: (206) 644-3663
24-Hr CompuServe CIS: 75300,1627 forum: GO METZ
24-Hr America Online AOL: METZSoft forum: GOTO METZ
24-Hr Internet E-mail INT: 75300,1627@compuserve.com

HOURS:    8:00 a.m. to 5:00 p.m., Monday through Friday (Pacific Time)

METZ acknowledges all trade names and trademarks used in this document as the property of 
their respective owners.



Installing METZ Phones
It's easy to install METZ Phones.    The installation application automatically copies the METZ 
Phones program files to your hard disk and sets them up for you.    The installation application 
also allows you to remove the METZ Phones application from your system.

METZ Phones may require that the DOS program Share be installed in order to run.    Share is 
included as part of DOS.    METZ Phones will offer to add a line to your AUTOEXEC.BAT file 
to load Share if it isn't already loaded.    Microsoft Windows for Workgroups and Novell 
Networks automatically provide Share support.
Installing METZ Phones
To install METZ Phones:

1. Start Microsoft Windows on your system.
2. Put the METZ Phones program disk in drive A or B and choose the Run command from 

Program Manager's File menu.    Then type:
a:\install.exe    or    b:\install.exe

in the Command Line box and choose the OK button.
3. If you are installing this version of METZ Phones for the first time, the Registration 

screen appears.    Enter your name and your company name, if applicable.    Then choose 
the OK button.

4. Use the suggested directory or type the name of the directory where you want to install 
METZ Phones, then choose the Continue button.

5. Choose the Install METZ Phones button to begin.    If you're not ready to install, choose 
the Exit Install button.

6. If Share is not running, the installation program will offer to modify your 
AUTOEXEC.BAT file to load Share automatically when you start your system.    (A 
backup of the current version of this file will be saved in the root directory as 
AUTOEXEC.MTZ.) Choose OK to modify this file, then OK to confirm.
Note:    Installation can proceed but METZ Phones may not run unless Share or Windows 
for Workgroups are running.    If you do not let METZ Phones modify your 
AUTOEXEC.BAT file, be sure to place the command Share in the AUTOEXEC.BAT file
before any commands that may start Windows.

7. When the installation is complete, you'll be asked to restart Windows.    If the installation 
program modified your AUTOEXEC.BAT file, you'll be asked to reboot your system.    
Choose the OK button to restart Windows or reboot your system.

Note:    If you need to reinstall METZ Phones, it can be done without first removing any existing 
files.    If you are reinstalling, skip step 3.    The suggested directory in step 4 will be the directory
that was specified during the previous installation.



Setting up METZ Phones

Here is a short overview of how to properly configure METZ Phones.    For a more detailed 
discussion, please see the Getting Started Guide or consult the on-line documents by clicking 
Help from the menu.

When starting METZ Phones for the first time you will be greeted by the Preferences dialog 
box.    In the Your Name box, enter the name that will identify you to other users on your 
network.    Be sure that the Paradox control file directory (PDOXUSRS.NET): box shows a 
directory that is accessible to all of the network users with whom you want to share address 
books.    You can also change other options.    When done, choose the OK button.

To configure your modem, choose Dial/Modem Settings... from the menu.    Choose the baud 
rate for your modem and then select the Auto Config button.



Starting METZ Phones

The installation program will automatically create an icon in Program Manager which you can 
use to launch METZ Phones.    If you would like to automatically load a database when METZ 
Phones is launched you have the following options:
Highlight the METZ Phones icon in Program Manager, select File Properties, then you can add a
database name after the METZPHO.EXE on the command line.    This will load a new copy of 
METZ Phones and tell it to open the database you enter.    Be sure to include the full directory 
path to insure that the database will be found.    A space is required after the .EXE.
Example: C:\WINDOWS\METZPHO.EXE C:\DATA\METZPHO.DB
You can also specify just a database name (i.e. METZPHO.DB) on the command line.    If 
Phones is already running, it will automatically appear and open the database, otherwise a copy 
of Phones will be launched with that database.    This may not work if you have another 
applications registered for the .DB extension, like Paradox for Windows.
Example: C:\DATA\METZPHO.DB
The third option is to specify a default database in the Phones File Preferences dialog.    This is 
the database which will be loaded if none are specified on the command line.



The Main Screen

You control METZ Phones with commands from the toolbar buttons and the pull-down menus.    
By placing your mouse over a button, the status bar will display the functions performed by that 
button.    Each menu item will display its options with one mouse click or by hitting the Alt key 
at the same time you enter that items underlined letter (for instance, enter Alt + i to access the 
List menu).

Begin with the File menu to open an existing file or create a new file.    The files you have used 
most recently are also listed here for fast access.    Choosing Open will allow you to select 
existing files from different directories and drives.    Choosing New will allow you to create a 
new address book or import data from another database.    

To create a new address book, choose New from the menu.    In the dialog box that appears give 
the new file a name that you want to see in the METZ Phones Title Bar and a file name of eight 
characters or less.    It will become a .DB file and it will hold the information you will store in 
this database.

To create an address book based on information in a different data format choose Import after 
creating your new .DB file from the New option.    This will open the Import dialog.    From the 
box labeled File/Format:, select the native format of the data you wish to import.    Then select 
the Source button to choose the file by name.    Its data will appear in the left list box, one entry 
at a time.    In the right list box will be a variety of fields that you can include in your records.    
By choosing which fields you wish to import, you will quickly build a layout design based on the
first card that will apply to every entry.    Start by attaching a field to a line in the right window 
by highlighting that field in the left list box, highlighting the proper line in the right list window 
and clicking the Attach button.      After youve finished with first card, give this layout design a 



name in the Layout box so you can use it again.    For a detailed discussion of Importing and 
Exporting data, please see the Help files on-line.

To customize your METZ Phones display, choose View, then Toolbars... and select options by 
checking the appropriate boxes.

A row of buttons representing the alphabet is below the toolbar buttons.    Clicking on any letter 
will show current address book entries beginning with that letter in the List window.    To see 
non-alphabetic characters that might be in your database, click on one of the arrows at either end 
of the row.



The List Window

This displays the results of how the entries in the current address book have been sorted, based 
on options chosen from the List and then View menus.    An alternate way of seeing all of the 
options under the List menu is by clicking your right mouse button when the cursor is anywhere 
in the List window.

The List window and the Record window can be maximized, sized and adjusted to taste.    To 
display the List window horizontally above the Record window, choose the Window menu and 
the Tile Horizontal option.    To view the List window alongside the Record window, select the 
Window menu and the Tile Vertical option.    Choosing the Window menu and the Split option 
will maximize the active window or return both windows to the screen if a window is already 
maximized.    The windows can also be resized with a mouse by dragging their common edge.

METZ Phones offers many data display options from the Choose List View dialog box (select 
List and then View from the menu to access this dialog box).    Control the criteria by which you 



display data from the three customizable columns of options.    This is a very powerful feature 
that allows you to specify which lists will be included in the display, how you wish to sort that 
list from a broad selection of choices and whether to display data in ascending or descending 
order.    The results of your sorting pattern will be displayed in the List window.    By 
highlighting an individual entry in the List window, its information will appear in the Record 
window.
Other options under the List menu allow the copying and pasting of    data between address 
books and let you specify search options.    You can create new lists with List/Find to 
immediately add the data you have sorted out into a new address book.    You can also quickly 
find a specific entry by using List/Locate and entering what you are searching for in the pop-up 
box that will open over the List window.



The Record Window

This window displays details about the highlighted entry in the List window.    When no entry 
has been chosen or you are creating a new entry, the Record window is known as the New 
Record window.    You control this window from the Record menu and the Command Bar which
displays buttons for frequently used commands.    By placing your mouse over a button, the 
status bar will display the functions performed by that button.    For further information about any
of these functions please consult the on-line documents by clicking Help.

The top row of buttons allow you to quickly select between information sets - main addresses, 
phone numbers, fields you define, two separate note attachments and storage for second and third
addresses.    To help in quick identification of where data is stored the buttons change color when
active and remain that color after becoming inactive when data is available.    Buttons where the 
database is empty will not change color.    For example, the phone numbers button will change 
color only when there is a phone number entered for the current entry.

The arrow keys move you one entry up (>) or down (<) the current list.    Move to the next 
section in the current list with the double arrows - to move forward and to move backward.

The commands represented by the buttons can also be found under the Record menu.    Either 
the buttons or the menu will give you total control of METZ Phones and its powerful tools for 
viewing sets of data.

Some fields have a description built-in.    To enter information into a field, <tab> to or click your
mouse in the field you wish to fill and type your entry.    The description will disappear without 
being highlighted when you begin typing.
The Main Address screen allows as many lines as you need for the longest addresses.



The phone button, or the Record menu and the 2 Phone Numbers option, lets you store 
unlimited telephone numbers.    Define as many telephone number types as you need with the 
Edit Telephone Types command.

The fields button, or the Record menu and the 3 Fields option, lets you store unlimited user 
definable information.    Define as many fields as you need with the Edit Field Types command.
Store notes in either or both of two separate, high capacity notepads attached to each entry by 
choosing one of the Notes buttons or using the Record menu and selecting the 4 First Notes 
or /5 Second Notes option.
Keep second and third addresses for any entry to separate professional and personal addresses by
selecting one of the address card buttons or by using the Record menu and choosing the 6 
Second Address or the 7 Third Address options.    Be sure to Save your entries and changes.

Define filters or group records in the Categories list.    You can sort by Categories from the 
Choose List View option under the List menu and the View option.



The Status Bar

Find out whats going on by checking the Status bar.    It displays helpful suggestions about what 
to do next, what various buttons do and the current date and time.
To identify the descriptions of a button, place your mouse cursor over that button.    Its function 
will appear in the Status Bar.



Managing Your Data

METZ Phones allows viewing data almost any way you choose through its vast sort and search 
functions.    Sharing data with other Windows applications is easy thanks to powerful DDE 
(Dynamic Data Exchange) commands, data Import/Export and hotkey access to the Clipboard.    
METZ Phones is fully compatible with the Microsoft® Office™.

Skim off just the information you need by choosing sort options from the Choose View List 
dialog under the List menu and its View option.

Find the record you want using List/Find... or the List/Locate... commands.

Include data from your address books in Mail Merges or custom reports    by using METZ 
Phones DDE commands to other Windows applications, including the Microsoft® Office™.    
For step-by-step instructions on using the versatile DDE commands please consult the Help 
documents on-line.

The import and export of data is handled easily.    To import from popular database file formats, 
choose File from the menu and the Import option.    Select the native file format of the data you 
wish to import, the files location from the Source button and the pertinent database fields then 
hit the Import button.    To export from METZ Phones to other databases, choose the File menu 
and the Export option.    From the dialog, select the data you wish to export and into which file 
format then hit the Export button.

Its even simple to copy a record into a .CSV file or other application by using the Hotkey paste 
feature.    From Edit/Hotkey & Clipboard Layouts menu, select the information you want to 
copy from the current record and click the Ok button.    The data you selected is copied to the 
Clipboard and automatically pasted into any Windows application.



Networking

From its inception, METZ Phones has been designed to maximize the flow of information in the 
network environment.    Users across your network can share database files quickly and 
effortlessly.

While a record is being modified other network users are not locked out from viewing that 
record, but they wont get the updated information until the editing has been completed.    This is 
very valuable in busy phone books where many people who require access to the information are
not delayed when a minor modification is made to the file.



Printing

Printing the information you see on-screen to labels, envelopes or reports is no problem.    To 
print a report of the current record, click the printer button on the toolbar or select the Record 
menu and the Print Record option.

To print labels, choose the File menu and the Print Labels option and then choose options from 
the dialog.    Ensure you have the correct settings before wasting labels by clicking the test 
button.

To print envelopes, select the File menu and then the Print Envelopes option to bring up the 
Envelope dialog.    Enter data by clicking the From and To buttons, then print.

METZ Phones remembers your printer settings each time you print without changing your global
settings to every other Windows application.

Choose the exact Avery® label that youll print on from the built-in library of templates or define 
your own parameters for complete control.

DDE links allow the use of a word processor, like Microsoft® Word™, to create custom reports 
and large mail merges based on data stored in your phone books.



Other Features

Everything about METZ Phones has been designed to make it easier for you to manage your 
telephone and address lists.    All of the powerful features that help you accomplish this may not 
be immediately apparent, however.

You can run METZ Phones all the time with only minimal demands on your system.    You have 
already discovered how useful METZ Phones is for managing data but you may not be aware 
that, when minimized into an icon, it returns much of its resources to the system.    Keep METZ 
Phones available at all times for speedy access to your address books.

Its easy to paste data between applications using the Hotkey (Ctrl + Alt + P).

When you need to dial a number that is listed in a document in another application, use the 
Hotkey dialing command (Ctrl + Alt + D) after highlighting the number to dial.

Convert files with METZ Phones Import/Export commands.    Try it with a .CSV databasefile.    
Choose the File menu and the New menu to create a new file.    Then select the Import option 
from the File menu to open the Import dialog.    Select the native file format, the files location, 
choose and attach fields you wish to import to your new address book, then click the Import 
button.    That is it.    METZ Phones does all the work.    In the process you have defined a 
reusable layout of data fields for future Importing.

Exporting is just as easy.    Choose to export all of the records in the Address Book or any records
you select.

DDE commands simplify many tasks.    They make powerful mail merges and completely 
customized reports quite simple to produce in a word processor, like Microsoft® Word™.



 Copyright 1989-1995 METZ Software, Inc.    All rights reserved.

METZ Software and the METZ logo are trademarks of METZ Software, Inc.

Microsoft  and Microsoft MS-DOS

 are registered trademarks and Windows
 is a trademark of Microsoft Corporation.

Other brand and product names are trademarks or registered trademarks of their respective 
holders



Reference Information

Menu Commands
File Menu
Edit Menu
View Menu
List Menu
Record Menu
Dial Menu
Window Menu
Help Menu

Keyboard Guide

Trouble Shooting



Keyboard Commands

If you prefer to keep your hands on the keyboard when you are working, you can use shortcut keys. For 
example, pressing CTRL+N displays the File New dialog.

Use the following shortcut keys when you're working with METZ Phones.

Press Command

Ctrl+N File New
Ctrl+O File Open
Ctrl+R File Rebuild Indexes
Ctrl+P File Print Report

Ctrl+Z Edit Undo
Ctrl+X Edit Cut
Ctrl+C Edit Copy
Ctrl+V Edit Paste

Ctrl+L List Locate
Delete List Delete Selections

Enter Record Save
Escape Record Cancel
F4 Record Next Call
F5 Record Time Stamp

F3 Dial Primary Number

F1 Help Contents



File Menu

From the File menu, you can open and close and manage databases, print reports, labels and 
envelopes, import and export data, check the current database status, select your preferences, and close 
METZ Phones.

For more information, choose from the following commands:
New
Open
Close
Save As
Delete
Rebuild Indexes
Print Report
Print Labels
Print Envelopes
Status
Preferences
Import
Export
Backup
Restore
Exit METZ Phones



File New Command
Description:
Specify the Address Book you wish to create and optionally enter a description.    When the Address Book
is open, the description will appear in the METZ Phones title bar.    The filename will appear in the title if 
the description is blank.    Use the File Status dialog to change the description.    The following options 
allow you to specify which file to create:
File Name: Type or select the filename you want to create.    This dialog lists files with the extension 

you select in the "List Files of Type" box.    The filename must have an extension of .DB, 
all other extensions will be ignored.

List Files of Type:
Select the type of file you want to open.

Drives: Select the drive you want to use. 
Directories: Select the directory you want to use.
Network... Choose this button to connect to a network location, assigning it a new drive letter. 

Special considerations:

The Address Book must have an extension of .DB.    Any other file extensions will be ignored.    
Additional Address Book files are stored in a subdirectory based on the database filename.    The 
subdirectory and will be created automatically.    Use the File Delete and File Save As commands
to manage your Address Books.



File Open Command
Description:
Select or enter the Address Book you wish to open.
The following options allow you to specify which database to open:
File Name: Type or select the filename you want to open.    This box lists files with the extension you 

select in the "List Files of Type" box. 
List Files of Type:

Select the type of file you want to open.    All METZ Phones files have an extension of .DB.
Drives: Select the drive in which METZ Phones stores the Address Book that you want to open.
Directories: Select the directory in which METZ Phones stores the Address Book that you want to open.
Network... Choose this button to connect to a network location, assigning it a new drive letter.



File Close Command
Description:
Closes the current METZ Phones Address Book.



File Save As Command
Description:
The following options allow you to specify the name and location of the Address Book you are about to 
save:
File Name: Type or select the filename you want to create.    This box lists files with the extension you 

select in the "List Files of Type" box.    All METZ Phones files must have an extension 
of .DB, any other extension will be ignored.

List Files of Type:
Select the type of file you want to save.

Drives: Select the drive you want to use. 
Directories: Select the directory you want to use.
Network... Choose this button to connect to a network location, assigning it a new drive letter. 

Special considerations:

The address book has a corresponding subdirectory containing additional files.    The File Save As 
command automatically copies the subdirectory and files to the new location.    If you want to move the 
address book to another location, use the Save As command to copy the file, then use the File Delete 
command to remove the old address book.



File Delete Command
Description:
The following options allow you to specify the name and location of the Address Book you are about to 
delete:
File Name: Type or select the filename you want to delete.    This box lists files with the extension you 

select in the "List Files of Type" box.    All METZ Phones files must have an extension 
of .DB, any other extension will be ignored.

List Files of Type:
Select the type of file you want to delete.

Drives: Select the drive in which METZ Phones stores the Address Book table file that you want to 
delete. 

Directories: Select the directory in which METZ Phones stores the Address Book table file that you 
want to delete.

Network... Choose this button to connect to a network location, assigning it a new drive letter. 

Special considerations:

Additional Address Book files are stored in a subdirectory based on the Address Book table filename and 
will be deleted automatically.    Delete will also remove the subdirectory if it is empty.



File Rebuild Indexes Command
Description:
Use the File Rebuild Indexes command to rebuild the METZ Phones database indexes.    Periodically 
rebuilding the indexes can help improve performance and reduce the database disk space.



File Rebuild Indexes Dialog
Description:
The File Rebuild Indexes Dialog allows you to choose which indexes (sort orders) are maintained for a 
database.    You can choose only the indexes you need and Phones will automatically create missing 
indexes later.    If you are sharing the database across a network, choose all of the indexes which will be 
used because Phones cannot generate a missing index if more than one user has the database open.    The 
index will be generated if a non-indexed sort order is selected in the List View Dialog.    If you are not 
sure what indexes are used by other users, simply choose all of the items on this dialog.



File Print Report Command
Description:
The following options are available in the Print Report dialog box:
Report Choose the report format you want to print:
          All information Prints all information for each record.
          All information with field labels Prints all information for each record with field descriptions.
          Address Book Prints Names, Addresses and Phone numbers.
          Phone Book Prints Names and Phone numbers.

Header Enter a header to print at the top of each page    If this item is blank, no header will be 
printed.

Range: Choose to print All records in the database or only records which are selected.    If no 
records are selected, the Selections option will be grayed.    Check One per page to 
print one record on each page.

Print: Specify the number of Copies you wish to print.    Check Page Numbers to print the 
page number at the bottom of each report page, and Separator Line to print a line 
between each record. 

Margins Select Inches or Centimeters as the units of measurement.    Specify the Top, Left, 
Bottom and Right page margins (measured from the paper edges inward) in decimal 
(.25).    Some printers have built-in page margins which are added to the margins you 
specify here.

Font Select the Font button to choose a different font from the Font dialog box.
Printer Select the Printer button to choose a different printer from the Print Setup dialog box
Print Select the Print button to print the report.
Cancel Select the Cancel button to exit the dialog without printing the report.

Special Considerations:

You can use the "File Print Labels" dialog as an alternative way to create reports.    Printing a label as an 
area on a page adds flexibility to the design of a custom report.



File Print Labels Command (Address Labels):
Description:
Print Address Labels will print labels from the currently open Address Book (this choice is unavailable 
if an Address Book is not open).    Print Text Labels changes the dialog box and offers different options.  
You could use this dialog as an alternative way to create reports by using plain paper instead of label 
sheets.    The following options are currently available:
Print Choose to print All records in the Address Book, or only records which are selected 

with the Selections radio button.    If no records are selected, the Selections option will 
be disabled.
Enter the number of times you want to print a label, then choose whether you want to 
print by Copies or per Record.    For example, if you want to print 7 labels for each 
record, enter 7 for the count and choose "per Record".    Each record label will be 
printed sequentially 7 times.    When you choose 7 "Copies", the entire print job will be 
printed 7 times.    The number of labels printed will be the same with either method, but
the organization across pages will differ.    When 1 is entered, selecting either item in 
the drop down has no effect.

Start at Label Specify the starting position (Row and Column) of the first label for the page.    This 
option is useful if you have a label sheet where the first few labels are missing.

Label Select the Label button to create or select a label from the Label dialog.
Layout Select the Layout button to change or select a label layout from the Label Layout 

dialog.
Font Select the Font button to choose a different font from the Font dialog.
Printer Select the Printer button to choose a different printer from the Print Setup dialog box
Print Choose the Print button to print the labels (only available if a selection has been made)
Test Choose the Test Page button to print a sample page of labels (only available if a 

selection has been made).    This option will draw lines where the text will appear on 
the label so that you can use a plain sheet of paper for the test.    The test page is handy 
for testing labels you have defined yourself or when the label settings have been 
changed.

Cancel Choose the Cancel button exit this dialog without printing any labels.

Special Considerations:

When using continuous feed labels, be sure to choose the correct paper size for the labels you are 
printing.    For example, the Avery 4013 label works properly with the Epson printer driver if you choose 
an 8-1/2" by 12" fan fold size.    The label page is 12 inches long in this case.



Label Command
Description:
Create or select a new label.    The following options are available:
Label Contains a list of labels which have already been defined.    Select the label you wish to 

use or modify, or type in the name of a new label you wish to define.
Measurement Select the unit of measurement for the printed page of labels.    Available selections are 

Inches or Centimeters.
Rows Enter the number of rows of labels down the page.
Columns Enter the number of columns of labels across the page.
Left Margin Specify the desired margin width from the left edge of the page.
Label Width Specify the label width.    All labels on a sheet are assumed to have the same width.
Right Spacing Specify the extra space between label columns.    This value may be an number, zero or 

left blank.
Top Margin Specify the desired margin from the top edge of the page.
Label Height Specify the label height.    All labels on a sheet are assumed to have the same height.
Bottom Spacing

Specify the extra space between label rows.    This value may be an number, zero or left
blank.

OK Select the OK button to accept the settings.
Cancel Select the Cancel button to close this dialog without saving any changes.
Delete Select the Delete button to remove the selected label from the list.

Special Considerations:

Margins are measured from the paper edges inward.    Some printers have built-in page margins which 
will be added to the margins you specify here.    Specify distances in    decimal notation (.25).    The 
information displayed by this dialog is stored in the file METZPHO.LBL.    If you run the METZ Phones 
installation program, the file will not be replaced unless it has been deleted.



Label Layout Command
Description:
This dialog box contains all of the features required for you to describe your custom Label Layout to 
METZ Phones.    The following options are available in the Label Layout dialog box:
Layout Description

Contains a list of layouts which have already been defined.    Select an existing layout 
to use or modify, or type in the name of a new layout you wish to define.

Erase Delete the currently selected Layout Description from the Layout list.
Justification: Choose how you would like the text justified on the label.
Label Text: Displays the current label layout.    Each of the record's fields is enclosed in square 

brackets [ ].    When the labels are printed, values from the records will be substituted 
for the values in brackets (the brackets are removed).    Characters outside of the 
brackets will be printed as they appear.    The label layout acts as a filter, allowing you 
to position the fields on the label and add extra text to appear on every label. 
Place the cursor in the Label field and press enter to create a new line or select the 
newline item from the Fields list.    Use Ctrl+Tab to insert tab characters.    

Database Fields:
This list displays the available Address Book fields.    You add these fields to the Label 
box on the left with the Add button to define how the data is placed onto the clipboard.

Add Select the <<Add button to add a selected field to the Label text box.    The field will be
placed wherever the cursor was positioned in the Label text box.

OK Select the OK button to accept the settings.
Cancel Select the Cancel button to close this dialog without saving any changes.



Font dialog box
Description: Select the font you would like to use.    To select the default System font, clear the font, 
style, and size settings, then choose OK.



Printer Setup Command
Description:
The following options allow you to select the destination printer and its connection.
Printer Select the printer you want to use.    Choose the Default Printer; or choose the Specific 

Printer option and select one of the current installed printers from the list box.    You 
install printers and configure printer ports using the Windows Control Panel. 

Orientation Choose Portrait or Landscape.
Paper Size Select the size of paper that the document is to be printed on.
Paper Source Some printers offer multiple trays for different paper sources.    Specify the tray here.
Options Displays a dialog box offering you additional choices specific to the type of printer you 

have selected.



File Print Labels Command (Text labels):
Description:
Print Text Labels allows you to print one or more labels from text you have entered.    Selecting Print 
Address Labels from the top pull down box changes the dialog box and offers different options, 
including printing labels from the currently open Address Book.    The following options are currently 
available:
Print Enter the number of labels or pages you wish to print, choose either Full Pages or 

Labels (the count will then be applied to this value), and specify the number of copies 
you wish to print.

Start at Label Specify the starting position (Row and Column) of the first label for the page.    This 
option is useful if you have a label sheet where the first few labels are missing.

Label Select the Label button to choose or select a label from the Label dialog box.
Text Select the Text button to change or select label TEXT from the Label Text Layout 

dialog box.
Font Select the Font button to choose a different font from the Font dialog box.
Printer Select the Printer button to choose a different printer from the Print Setup dialog box.
Print Choose the Print button to print the labels.
Test Choose the Test Page button to print a sample page of labels.    This option will draw 

lines where the text will appear on the label so that you can use a plain sheet of paper 
for the test.    The test page is handy for testing labels you have defined yourself or 
when the label settings have been changed.

Cancel Choose the Cancel button exit this dialog without printing any labels.

Special Considerations:

When using continuous feed labels, be sure to choose the correct paper size for the labels you are 
printing.    For example, the Avery 4013 label works properly with the Epson printer driver if you choose 
an 8-1/2" by 12" fan fold size.    The label page is 12 inches long in this case.



Label Text Command
Description:
Use this dialog to enter the text you want printed on the label.    The following options are available in the 
Label Text dialog box:
Description Contains a list of layouts which have already been defined.    Select an existing layout 

to use or modify, or type in the name of a new layout you wish to define.
Label Text: Displays the current label text.    Enter the text you want to print on the label.
Justification: Choose how you would like the text justified on the label.
OK Select the OK button to accept the settings.
Cancel Select the Cancel button to close this dialog without saving any changes.
Delete Select the Delete button to remove the currently selected Layout Description.



File Print Envelopes Command
Description:
The following options are available in the Print Envelopes dialog box:
Print Choose All to print envelopes for the entire list, or Selections to print envelopes for 

only those records selected.    Specify the number of Copies of each envelope you want 
to print.

Printer Select the Printer button to choose a different printer from the Print Setup dialog.    
Choose the envelope sizes from the Print Setup dialog box.

From Select the From button to customize the way the return address will appear.
To Select the To button to customize the way the destination address will appear.

Print Choose the Print button to print the envelopes.
Test Page Choose the Test Page button to print a sample envelope.    This option will draw lines 

where the text will appear on the envelope so that you can use a plain sheet of paper for
the test.    The test page is handy for testing envelopes you have defined yourself or 
when the envelope settings have been changed.

Cancel Choose the Cancel button exit this dialog without printing any envelopes.

Special Considerations:

When selecting your printer settings, it is important that you select the correct Orientation, Paper 
Size and Paper Source.    A typical configuration may be:
Orientation Landscape
Paper Size Envelope #10
Paper Source Envelope Manual Feed

These settings will be saved so that you do not have to select them each time you print envelopes.    
These settings do not affect your system printer settings.



Envelope "To" Command
Description:
The following options allow you to customize your "To" address layout:
Description: Select from previous layouts, or enter a new one here.    The Erase button deletes the 

highlighted description.
Erase Select the Erase button to delete a highlighted description.
Font Select the Font button to choose a font using the Font dialog.
Justification The justification determines how the To address text is justified within the To address 

position.
Position Imagine an invisible rectangle around the address.    The Left and Top positions indicate 

the location of the upper left corner of the address rectangle on the envelope, and the 
Width and Height positions indicate the dimensions of the address rectangle.    The To 
address text is printed within this rectangle.

Address Text, Database Fields and <<Add Button
The text that will appear on the envelope comes from the Address Book record field, 
indicated with square brackets [ ] in the Address Text box.    Add to this list by 
highlighting the desired field in the Database Fields box and press the <<Add button.    
Remove fields from the Address Text box by highlighting the desired line and pressing 
the Delete key.    Any text not in brackets will be printed as is.

OK Choose the OK button to accept the current address text layout.
Cancel Choose the Cancel button to abandon the current address text layout without saving.



Envelope "From" Command
Description:
The following options allow you to customize your "From" address layout:
Description: Select from previous layouts, or enter a new one here.    The Erase button deletes the 

highlighted description.
Erase Select the Erase button to delete a highlighted description.
Font Select the Font button to choose a font using the Font dialog.
Justification The justification determines how the From address text is justified within the From 

address position.
Position Imagine an invisible rectangle around the address.    The Left and Top positions indicate 

the location of the upper left corner of the address rectangle on the envelope, and the 
Width and Height positions indicate the dimensions of the address rectangle.    The From
address text is printed within this rectangle.

Return Address Text
Type in the return address you wish to be printed on the envelope.

OK Choose the OK button to accept the current address text layout.
Cancel Choose the Cancel button to abandon the current address text layout without saving.



File Status Command
Description:
The following options are available in the Status dialog box:
Description This field contains the current Address Book description or blank if no description has been

entered.    You can change the description and press OK to modify the Address Book 
description.

Database Displays the filename for the currently open Address Book. 
Directory Displays the directory containing the currently open Address Book. 
Total Size Displays the total Address Book size (including indexes and sub-tables) in bytes.
Number of Records

Displays the total number of records stored in the Address Book. 
Number of Telephone Types

Displays the total number of Telephone Types defined for this Address Book. 
Number of Categories

Displays the total number of Categories defined for this Address Book. 
OK Choose the OK button to save any changes to the database description.



File Preferences Command
Description:
The following options are available on the Preferences dialog box:
Your Name Specify your name as it will appear to other users in a network environment.    The current 

user of a record is displayed when multiple users attempt to modify the same record.
Paradox control file directory

METZ Phones uses the Borland Paradox Engine to manage your Address Books.    The 
engine uses a file called PDOXUSRS.NET to keep track of who is using each database.    
The file is created automatically (even if accidentally deleted).    You just need to indicate 
where it should be located.
Make sure every network user has the same drive letter and directory in this setting.    Every
user must have read/write access to the directory and the directories containing your 
network phone books.    It is ok to point this directory to one of your phone book 
directories.
Note: for a non-network installation, the default setting is the root directory of your local 
disk drive ("C:\").    If you change this setting, you may need to delete the old 
PDOXUSRS.NET.

Default Database
If you would like METZ Phones to open an Address Book automatically when it starts up, 
specify the name and path of the file here.    This setting is optional.

Browse Select the Browse button to choose the Address Book name and path.
Paste Hotkey:

METZ Phones allows you to insert record information into another Windows application 
by just pressing the Hotkey PASTE key combination.    Select the hotkey combination you 
want to use.    The default is CTRL+ALT+P.    You should use a CTRL+ALT combination to
avoid conflicts with other Windows applications.

Dial Hotkey: METZ Phones allows you to auto-dial a phone number within another Windows 
application. Select the hotkey combination you want to use.    The default is 
CTRL+ALT+D.    You should use a CTRL+ALT combination to avoid conflicts with other 
Windows applications.

Activate Hotkey: The Activate Hotkey gives you a quick way to access Phones if it is currently 
running.    When you press this hotkey, Phones will appear.    Phones does need to be 
running.    For best results, have Phones automatically loaded as an icon when you start 
Windows.    You should use a CTRL+ALT combination to avoid conflicts with other 
Windows applications.

Automatically Save Changes to records
Check this option to have Phones automatically save changes to a record .    Note: when this
option is checked, you will need to choose the Address Cancel menu item or button if you 
wish to prevent changes to a record from being saved.    

Automatically count calls
Each time you auto-dial a number from a record, the call count and last call date are 
updated.    The record will be marked as changed and will need to be saved or cancelled.    If
you want to disable the call counting feature, check this option.

Disable opening screen
If you would like to remove the informational screen when METZ Phones is first started, 
check this option.

Insert Time Stamp
When you select the Time Stamp Notes Command from the Record menu, METZ Phones
needs to know where to place the date and time stamp in the Notes field.    You do this by 



selecting either Top of Notes (to have the time stamp placed at the beginning of the notes 
text), Cursor (to place the time stamp at the current cursor position), or End of Notes (to 
have the time stamp placed at the end of the notes text).    This option also affects the cursor
position when the notes are first displayed.

International
Enter the translation for the words "Copy" and Paste if you use a non-English language.    
For example, the German term for copy is "kopieren".    If you use any non-English 
products, the Phones hotkey features may need to use the local language terms for the Copy
and Paste commands of the Edit menu.

OK Choose the OK button to save any changes.
Cancel Choose the Cancel button to close this dialog without saving any changes.



File Import Command
Description:
METZ Phones can convert data from another application into the Address Book database format.    The 
most common method is to save a .CSV (Comma Separated Values) formatted file from the other 
application and import it into METZ Phones from this dialog box (refer to the other application's 
documentation for help on creating CSV files or exporting data).

Each record in the .CSV file contains one or more fields separated by commas.    Because the fields 
can be in any position or order, this dialog box allows you to match METZ Phones Address Book record 
fields with the .CSV file fields.    The left list box displays the data for the first record of the file you are 
importing.    It lists each field in the record from top to bottom.    The right list box displays a variety of 
fields in an Address Book record.    By attaching fields on the right to those on the left, you define how the
entire file is imported.    Select an item in each list box and choose the Attach or Detach button or double 
click in the list box to assign import file fields to Address Book fields.

You may assign more than one field on the left to a database field on the right, and they will be 
automatically merged into a single field in the new Address Book record as they are read in.    When you 
match up Address Book fields to an import file record, the match applies to all the records in the import 
file.

There are two ways to import METZ Phones 3.x version files.    The first way is to save the file from 
the METZ Phones 3.x application with a .CSV extension and define it within this dialog box as a .CSV 
file.    The other approach is to select the METZ Phones 3.x format and match the records up field by 
field.    You may find it necessary to make additional modifications to some records after the data has been
imported.

You will need to give the format a Layout Description so it can be saved for use again later.    You do
need to create or open a database before you can import any data.

Note:    If you are importing a CSV or TAB file format from a DOS application and need to have the 
characters translated from the OEM to the Ansi character set, add the following line to the 
METZPHO.INI under the [METZ Phones] section:
OEM=True

Be sure to remove this setting when you are finished.

File Import Options
The following options are available in the Import dialog box:
Format Select the type of file format you wish to import.
Source Choose the Source button to select a file to be imported.    You should select the appropriate

File Format before choosing the Source button.
Layout Description:

Enter or select the name for this file layout.    You can then reuse this layout the next time 
you import or export a file, or define a new file layout.    These file layouts are also used in 
the File EXPORT dialog box.

Erase Select the Erase button to delete the currently selected Layout Description from the list.
Record #: Shows the current record position for the import file.    Use the Next and First buttons to 

display other records and preview your layout for correctness.
Database Field:

Displays the import field name which has been matched to the new Address Book record's 
field.    To the left is all or part of the record field value.

Database Fields:
This list contains import field types.    For example, 'First Middle Last' defines an import 
field containing the first, middle and last names.    The import process will separate the 
name into corresponding fields of the METZ Phones Address Book's records.    You match 



(attach) these fields with the import record fields on the left to define how the data is placed
into the current METZ Phones Address Book records.

Attach Select the <<Attach button to match a selected import file field with a selected Address 
Book record field description.

Detach Select the Detach>> button to clear a selected import file field description.
First Select the First button to display the first record of the import file.
Next Select the Next button to display the next record of the import file.
Import Select the Import button to begin importing the file.
Cancel Choose the Cancel button to close this dialog without importing any data or saving 

changes.
Add undefined fields to Notes

Check this option if you wish to place undefined fields into the METZ Phones notes 
section.    You can manually cut-and-paste information into a different field when editing a 
record.

File Import Tips
Special fields:
METZ Phones has several special import field types to help make it easier to import a variety of 
information.    Some of the specialized fields are:

"Address" - You can attach this field type to one or more import fields.    Each field will be appended
to the address contents during import.

"Notes" & "Notes2" - You can attach this field type to one or more import fields.    Each field will 
be appended to the corresponding notes field contents during import.

"Phone Type & #" - Phone numbers exported from PackRat may contain the phone type with the 
telephone number (i.e. "Business 555-1212").    Phones will automatically add the 
telephone type to it's own telephone type list and place the telephone number in the 
appropriate location.    If a record contains a duplicate type, the types will be appended 
with 01 through 99 as necessary.

Tips for Importing METZ Phones 3.x data:
The following is one possible layout for your METZ Phones 3.x data:

Last, First Middle
Phone: Home
Phone: Office
Phone: Other
Address
Address
Address
City State Zip
Notes

Change the field types where appropriate to best match your data.

Tips for Importing Windows Cardfile files:
Cardfile data is very unstructured, making importing a challenge.    The more you can standardize the data
from card to card, the easier it will be for you to import the data.    For example, if your cards contain 
address information, make the first 4 lines of each card the address area, placing the City, State, and Zip 
on the fourth line.    You can then define a layout in the METZ Phones Import dialog that will match the 
format of the Cardfile Data.
METZ Phones splits the top (index) line of each Cardfile card into two records containing the name and 



phone number.
With this in mind, the following is one possible layout example for Cardfile data:

Last, First Middle
Phone: Office
Address
Address
Address
City, State, Zip
Notes

You can import data into a temporary database until you are comfortable with the settings.



File Export Command
Description:
The Export command allows you to place selected information into a variety of output files which may be
used for input into a variety of third party applications.    If you simply wish to transfer or copy records to 
another Phones database, use the List Copy Records or the File Backup commands.

Note:    If you are exporting a CSV or TAB file format for a DOS application and need to have the 
characters translated from Ansi to the OEM character set, add the following line to the METZPHO.INI 
under the [METZ Phones] section:
OEM=True

Be sure to remove this setting when you are finished.

The following options are available in the Export dialog box:
Export Choose to export all records in the Address Book or only records which are currently 

selected.    If no records are selected, the Selections option will be grayed.

Options Choose from the following export options:
Remove CR/LF

Some database fields, such as an address or notes, may contain carriage return/line feed 
(enter) characters.    This setting will replace each CR/LF pairs with a single space.    Some 
applications cannot import CSV or TXT files containing embedded CR/LF values.

Change CR/LF to CR
Some database fields, such as an address or notes, may contain carriage return/line feed 
(enter) characters.    This setting will replace each CR/LF pairs with a single CR (carriage 
return).

Keep CR/LF
This setting exports database fields as they are without removing carriage return/line feed 
characters..

Include Field Names
Check this option if you would like the first record of the export file to contain the export 
field names.    This option helps you easily determine the contents of the file when 
importing into data into another application or another copy of METZ Phones.

Enclose in Quotes
Check this option if each field should be enclosed in double quotes.    This option is 
provided for CSV and TXT file formats.    Normally, you do not need to check this option 
unless the application you are importing the data into requires double quotes around all 
fields.

Type: Select the type of file format you wish to export.
File: Choose the File button to assign a file name and destination to the data you are exporting.    

Choose the desired file format from the Output Type before selecting the File button.
Layout Description

Enter or select the name for your export file layout.    You can reuse the layout the next time
you export or import a file.    The file layouts are shared with the File Import dialog box.

Erase Select the Erase button to delete the currently selected Layout Description from the list.
Fields to export:

This list displays the selected Address Book record fields which will go into each record of 
the export file.    You add fields to this list from the Database Fields list using the <<Add 
button.

Database Fields:
This list contains many export field types.    For example, 'First Middle Last' defines an 



export field containing the first, middle and last names separated by spaces.    The export 
process will combine the corresponding fields of each METZ Phones Address Book    
record into this format.    You add these fields to the "Fields to export" list    to define how 
the data is placed into the export file.

Add Select the <<Add button to add a selected export field to the "Fields to export" list.
Remove Select the Remove>> button to remove the selection from the "Fields to export" list.
Up Select the Up button to move a selected field up one position in the list.
Down Select the Down button to move a selected field down one position in the list.
Export Choose the Export button to begin the export process.
Cancel Choose the Cancel button to close this dialog without exporting any data.



File Backup Command
Description:
Use the Backup command to store a copy of the current database (or selected records) in a single file.    
The file may be used for backup purposes, or to transfer the database to another PC, or to transfer records 
to another database.    When the backup is restored, the customizable fields will also be restored.    
Note:    If you want to backup only part of your database, you must select the records you want to backup 
and choose the Selections option in the Backup As dialog.    Otherwise, all records in the database will be 
included in the backup file.



File Restore Command
Description:
Use the Restore command to load information stored in a Phones backup file created by the File Backup 
Command.    By default, the Restore commands adds records to your database.

If you are restoring records into an existing database, you can choose from the following options after 
selecting the file you want to restore:
Add all records to the database

All records will be appended to the database, existing records will remain unchanged.
Replace all matching records

Any record with a matching name and company will be replaced,    except when the 
modified date of the records are identical.

Ignore all matching records
If a record with a matching name and company already exists in the database, the record 
will not be added.



Open previous file(s):
METZ Phones lists up to 6 of the last files you have opened at the bottom of the File Menu.    Click on the
file name or press the corresponding number to reopen that file.



File Exit Command
Description: Closes METZ Phones and any database currently open.



Edit Menu

From the Edit menu, you can access clipboard data, select records, set the hotkey and clipboard layout
settings and update categories, telephone types, salutations, titles, companies, and field types.

For more information, choose from the following commands:
Undo
Cut
Copy
Copy Address(es)
Paste
Clear
Select All
Hotkey & Clipboard Layouts
1 Categories
2 Telephone Types
3 Salutations
4 Titles
5 Companies
6 Field Types



Edit Undo Command
Description:
Use this command to reverse the last editing action, if possible.    The Undo command is grayed on the 
menu if you cannot reverse your last action.



Edit Cut Command
Description:
Removes the currently selected (highlighted) text from the screen and copies it to the Windows clipboard 
(unavailable if no text is currently selected).    Cutting text to the clipboard replaces the contents 
previously copied there.



Edit Copy Command
Description:
Copies the currently selected (highlighted) text from the screen to the Windows clipboard (unavailable if 
no text is currently selected).    Copying text to the clipboard replaces the contents previously copied 
there.



Edit Copy Addresses Command
Description: Use this command to copy information to the Windows clipboard (unavailable if no 
record is currently selected).    Use the Hotkey & Clipboard Layouts dialog box to customize the format 
of the information placed in the clipboard.    Copying text to the clipboard replaces the contents previously
copied there.
All of the selected records will be copied to the clipboard.



Choose a Clipboard Layout dialog box
Description:
METZ Phones provides an easy way to copy information from an Address Book directly into the 
clipboard.    This dialog lets you choose the format of the data to be placed in the clipboard.    If only one 
layout is defined, that layout will be used and this dialog will not appear.



Edit Paste Command
Description: Paste the Windows clipboard's contents at the insertion point (unavailable if the clipboard
is empty).



Edit Clear Command
Description: Clears selected (highlighted) text.



Edit Select All Command
Description: When the cursor is within a field of text, this command selects (highlights) all the text.



Edit Hotkey & Clipboard Layouts Command
Description: METZ Phones provides an easy way to copy 
information from an Address Book record to the Windows clipboard or directly to another Windows 
application.    This dialog lets you define the format of a record's information to be copied to the clipboard
when you choose the Hotkey PASTE function or the Edit COPY ADDRESS command.

The following options are available on the Edit Hotkey & Clipboard Layouts dialog box:

Layout Description:
Select from previous layouts, or enter a new one here.    The Erase button deletes the 
current description.

Erase Select the Erase button to delete a highlighted description.

Layout Filter Displays the template to be used for filtering a record's fields prior to copying text to 
the Windows Clipboard.    The record's fields are enclosed in square brackets [ ] and are
substituted with actual record values when you use the Hotkey Paste function or select 
the Edit Copy Address command.    Any template characters not surrounded by square 
brackets will be printed the way they appear.    This enables you to add extra text which 
will always appear as part of the clipboard text, such as
"Dear [SALUTATION][LAST],"
Place the cursor in the Layout Filter field and press Enter to create a new line or select 
the newline item from the Fields list.    Use Ctrl+Tab to insert tab characters.    

Database Fields This list contains database field types.    You add these fields to the Layout Filter edit on
the left with the Add button to define how the data is formatted.

<<Add Add any selected field to the Layout Filter box.    The selected field will be placed 
wherever the cursor was positioned in the Layout Filter box.

OK Closes the dialog and saves changes.
Cancel Closes the dialog without saving changes.



Hotkey Paste Dialog
Description:
The following options are available on the Hotkey Paste dialog box:

Paste Layout Choose the Paste Layout filter defined in the Edit Hotkey & Clipboard Layouts dialog 
box.

Records Choose one or more records you wish to paste into the current application.
Paste Pastes the selected records into the current application using the selected Paste Layout 

filter.
Cancel Closes the dialog without pasting any information.



Edit Categories Command:
Description:
Each category can be used to classify or group records in the Address Book.    You could, for example, use
the category "RESTAURANT" to identify all of the records containing restaurants.    The following 
options are available:
Categories list box

Select (highlight) the Category you wish to change or delete. 
Add Displays the Add Category dialog box.    Type in the name of the Category you wish to add.   

Alternatively, you may simply type the new Category name in the Category field in the 
Record Window.

Change Change the selected category.    You will be prompted for the name of a new category with the
Change Category dialog box.    If the new category already exists, you will be asked if you 
want to combine the old Category with the new category, allowing you to combine two or 
more categories.

Delete Delete the selected Category.    You will be prompted with the Delete Category dialog box 
for confirmation.

Close Close the dialog.



Edit Telephone Types Command:
Description:
Add new Telephone Types or make changes to the existing Telephone Types for the entire Address Book.  
Each type can be used to define different types of telephone numbers.    You could, for example, use the 
type "CAR PHONE" to define a field which will contain that type of telephone number for all of the 
Address Book's records.    You can also adjust the order of the Telephone Types with the Up or Down 
buttons.    The following options are available:
Types list box

Select (highlight) the Telephone Type you wish to change or delete. 
Add Displays the Add Telephone Types dialog box.    Type in the name of the Telephone Type 

you wish to add.
Change Change the selected Telephone Type.    You will be prompted for the name of a new 

Telephone Type with the Change Telephone Type dialog box.
Delete Delete the selected Telephone Type.    You will be prompted with the Delete Telephone Type 

dialog box for confirmation.    Warning: this will delete all the telephone numbers in the 
Address Book associated with this Telephone Type.

Up Move a selected telephone type up one position in the list.    This also repositions the type in 
the record view screens.

Down Move a selected telephone type down one position in the list.    This also repositions the type 
in the record view screens

Close Close the dialog.



Edit Salutations, Titles, or Companies Command
Description:
Modify the items that appear in the list box for each of these fields.    You can add, change, and delete 
items in the list by using your mouse or keypad.    The available options are Clear (removes all items on 
the list), OK and Cancel



Edit Field Types Command:
Description:
Add new Field Types or make changes to the existing Field Types for the entire Address Book.    Each 
type can be used to define different types of information.    You could, for example, use the type 
"Birthday" to define a field which will contain birthdate information for all of the Address Book's records.
You can also adjust the order of the Field Types with the Up or Down buttons.    The following options are
available:
Types list box

Select (highlight) the Field Type you wish to change or delete. 
Add Displays the Add Field Types dialog box.    Type in the name of the Field Type you wish to 

add.
Change Change the selected Field Type.    You will be prompted for the name of a new Field Type 

with the Change Field Type dialog box.
Delete Delete the selected Field Type.    You will be prompted with the Delete Field Type dialog box

for confirmation.    Warning: this will delete all the values in the Address Book associated 
with this Field Type.

Up Move a selected Field type up one position in the list.    This also repositions the type in the 
record view screens.

Down Move a selected Field type down one position in the list.    This also repositions the type in 
the record view screens

Close Close the dialog.



View Menu

From the View menu, you can customize the appearance of METZ Phones.

For more information, choose from the following commands:
Toolbars



View Toolbars Command
Description:
Use this command to choose how you want Phones to display the toolbars.    Uncheck or check items to 
disable or enable the options.

Main Window Toolbars
Standard Displays the main toolbar which contains buttons representing common commands.
Alphabet Displays the alphabet toolbar which provides an easy way to access records.
Status Bar Displays the date, time, and other information across the bottom of the main window.

Color Buttons Toggles the button images from Color or Black and White.
Large Buttons Toggles the button images from a Large or Small size.

Record Window Toolbars
View Buttons Displays the large record window buttons, allowing you to quickly display different 

groups of information for a record.
Commands Displays the record window command buttons, representing frequently used record menu

commands.



List Menu

The List Menu applies to the List Window.    Use the List menu to choose how records are sorted and 
displayed and to perform operations on the entire list or selected records.

For more information, choose from the following commands:
View
View Pending Calls
Font
Copy Record(s)
Paste Record(s)
Select Range
Select All
Deselect All
Delete Selections
Find
Replace
Assign Categories
Locate



List View Command
Description:
Choose the way you want to display the Address Book records in the List View window.    The dialog box 
changes as you select the List items

List Columns Text:
The List View window can display up to three colums of record information.    Choose 
the fields you want displayed in each column of the List Window or "Blank" to leave the 
column empty.    Choose "Blank" if you do not wish to display any data in a column.    
Choose "Sort Field" to display the currently selected sort order value in the column.    If 
more than one field has "Sort Field" selected, each of those columns will automatically 
display the next available sort value.    For example, if the current sort order is by name 
and all the dialog fields are set to "Sort Field", the list columns will display as follows:    
Name    Company    Title.

List: All Records displays the entire Address Book in the List View window. Rolodex displays 
the List like a rolodex (when "A" is pressed, only records beginning with "A" are 
displayed, etc).    Categories arranges the List by category, much like the yellow pages of 
a telephone book.    Calls displays the records based on a range of calls.    Current List 
lets you sort the current list of records, and Selections lets you sort and display only the 
currently selected records.    The following options are available:

List View Command: (All Records)
Sort by: Choose the fields you wish to sort the database by.    The List window will then display 

the records in the order you choose.
Order: Choose an ascending or descending sort order.

List View Command (Rolodex)
Sort by: Choose the fields you wish to sort the database by.    The List window will then display the

records in the order you choose.
Order: Choose an ascending or descending sort order.

List View Command (Categories)
Sort by: Choose the fields you wish to sort the database by.    The List window will then display the

records in the order you choose.
Result: Select the desired output for the list window.    Select Normal to have the list window 

display the selected categories with a list of records for each category.    Each category will
list all of the records that contain that category, thus a record may appear    under more 
than one category.    Select Summary to display a single list of records which match one 
or more of the selected categories.    Even though a record may contain more than one of 
the selected categories, it will only appear in the list once.    Select Union to display a list 
of records which contain all of the selected categories.    Each record must contain every 
selected category, records which do not contain every selected category will not be listed.

Categories list box:
The Categories listbox is available when the Categories display type is selected.    Choose 
the categories you wish to have displayed.

All/None Click the All button to select all of the category values.    Select None to deselect all 



categories.

List View Command (Calls)
Order: Choose an ascending or descending sort order.

Date Range:
From Choose the From button to select a beginning date for a range of calls to be displayed in 

the List View Window.    Click here to view the Select Date dialog.
Thru Choose the Thru button to select an ending date for a range of calls to be displayed in the 

List View Window.    Click here to view the Select Date dialog.

List View Command (Current List)
Sort by: Choose the fields you wish to sort the contents of the List Window by.    The List window 

will then display the records in the order you choose.
Order: Choose an ascending or descending sort order.

List View Command (Selections)
Sort by: Choose the fields you wish to sort the selected records in the List Window by.    The List 

window will then display the selected records in the order you choose.
Order: Choose an ascending or descending sort order.

OK Choose the OK button to save the selections.
Cancel Choose the Cancel button to close this dialog without saving any selections.



List View Pending Calls Command
Description:
Selecting this command, or pressing the Tool Bar tool is similar to selecting Calls from the List View 
Command Sort by group.    However, this command will automatically display records with a Next Call 
date value less than or equal to todays date.    Use this command to view the outgoing calls you have 
scheduled for today.



List Font Command
Description: Select the Font, Font Style, and Size of the font that the List View window will use.    
Clear each of these items to restore the default system font.



List Copy Record(s) Command
Description: Copies the selected Address Book records to the Windows Clipboard, you can then paste 
the records into a different Address Book.



List Paste Record(s) Command
Description: Pastes Address Book records from the Windows Clipboard into the current Address 
Book.    Records are copied to the clipboard with the Copy Record(s) command in the List Menu.



List Select Range Command:
Description:
The Select Range dialog allows you to select a group of records based on their position in the List 
window.    This is useful for printing out batches of labels, or for printing a portion of your list at a time.    
The following options are available on the Select Range dialog box:
From Enter the beginning record number of the range you wish to select.    The first record is 

number 1.
To Enter the last record number of the range you wish to select.    By default, the last possible 

record number is displayed.
Keep Prior Selections

Select this option if you want to have the List window maintain the selections it already has 
marked.    Otherwise, all previous selections will be unmarked.

OK Choose the OK button to save the selections.
Cancel Choose the Cancel button to close this dialog without saving any selections.



List Select All Command
Description: Use this command to select all items in the List window.



List Deselect All Command
Description: Use this command to deselect all items in the List window.



List Delete Selections Command
Description: Use this command to delete all selected records in the List window.    Use the File Delete 
command to clear the entire Address Book.



List Find Command
Description:
Search the Address Book, the current List, or selected records for specified text.    The following options 
are available in the Find dialog box:

Please Note:    Searching for blank Category values is supported but support for locating blank Telephone
Numbers or User Fields is not.    Please let us know if you need this additional feature.

Text: Enter the text you wish to search for.    You can also search for non-blank or blank fields.  
For example, to search for records with a blank (or empty) LastName, leave the search 
text field blank and choose the LastName field in the Search dropdown.    To perform the 
opposite search (LastNames which are not blank), place an exclamation point in the 
search text field.

Match Case: Select Match Case if you want to find records that match the search text exactly as you 
type it (upper and lower case).    Otherwise, any text which matches, regardless of case 
will be found.

Match Whole Word Only:
Select Match Whole Word Only if you are searching for a particular word and don't 
want to allow longer words which may include the search text.

Begins With: Select Begins With to search only for fields that begin with the search text.

Search: Choose the Address Book field you wish to search.  All Fields will search the entire 
record, including the notes.    The Selections button will search only the records selected 
in the List window.    The Entire Database button will search all records in the Address 
Book.

Current List: Select this option if you wish to search only the records displayed in the List View 
window, skipping all other database records.    The current list may not necessarily 
contain all database records.    It could contain a list from a previous search or a range of 
records selected by the current List View dialog settings.    Choose Entire Database if 
you want to insure that all records in the Address Book are searched.

Selections: Select this option if you wish to search only the records currently selected in the List 
View window, skipping all other records.

Entire Database:
Select this option if you wish to search the entire database, regardless of which records 
are displayed in the List View window.

Keep Prior Selections:
Select this option if you wish to have the List window keep the selections currently 
highlighted before the search.    A new list will be created containing the records found, 
plus the currently selected records.    The current number of selected records is displayed 
to the right of this option.

Create new List from search results:
Select this option if you want to have the List window display only the records found.

Find Next: Locate the next record containing the search text.
Find All: Locate every record containing the search text.

Special Considerations:
The List window may or may not reflect the actual list of records in the database.    The results of previous
searches, or a setting in the List View dialog can affect the contents of the List window.



Find Tips:
With these advanced options, you can perform Boolean searches using the Find dialog.
Boolean "Not" Place an exclamation point (!) in front of the text to search for records that don't contain

the specified text.
Boolean "Or" Use the Keep Prior Selections option to expand or refine the search results.    If you 

wanted to find all records containing the words "Student" or "Teacher", first run the 
search using the text "Student", then check the Keep Prior Selections option and run 
the search again with the word "Teacher".    The list will now be the combination of 
records containing either word.

Boolean "And" To create a list of records containing the text "Student" and "Teacher", search on 
"Student", then check the Selections search option, and make sure Keep Prior 
Selections is not checked.    Choose Find All, and the resulting list will be records 
containing both text values.



List Replace Command
Description:
Searches the Address Book, the current List, or selected records and replaces specified text.    The 
following options are available in the Replace dialog box:

Please Note:    If you wish to rename or remove Categories, Telephone Types, or User Defined Fields you
must use the corresponding menu item on the Edit menu instead.    Also, searching and replacing blank 
Category values is supported but support for replacing blank Telephone Numbers or User Fields is not.    
Please let us know if you need this additional feature.

Find What: Type the text or information you wish to find.
Replace With: Type the text you want to use as replacement text, or paste it from the Clipboard.    To 

delete the text in the Find What box, leave the Replace With box empty.
Match Case: Select Match Case if you want to find text which matches the search text exactly as you 

type it (upper and lower case).    Otherwise, any text which matches, regardless of case 
will be found.

Match Whole Word Only:
Select Match Whole Word Only if you are searching for a particular word and don't 
want to allow longer words which may include the search text.

Begins With: Select Begins With to search only for fields that begin with the search text.

Search: Choose the Address Book field you wish to search.  All Fields will search the entire 
record, including the notes.    The Selections button will search only the records selected 
in the List window.    The Entire Database button will search all records in the Address 
Book.

Current List: Select this option if you wish to search only the records displayed in the List View 
window, skipping all other database records.    The current list may not necessarily 
contain all database records.    It could contain a list from a previous search or a range of 
records selected by the current List View dialog settings.    Choose Entire Database if 
you want to insure that all records in the Address Book are searched.

Selections: Select this option if you wish to search only the records currently selected in the List 
View window, skipping all other records.

Entire Database:
Select this option if you wish to search the entire database, regardless of which records 
are displayed in the List View window.

Next >: Press the Next button to begin the search.    Once a match is found you will have the 
opportunity to determine what action will be taken in the Replace dialog described below.

Replace Dialog
Description:
After you press the Next button in the first List Replace Dialog, the first match is displayed in this dialog 
with options for the next action.    The following options are available in the Replace dialog box:

Replace: Changes the selected text or formatting to the text or formatting in the Replace With box, 
and then finds the next occurrence.

Replace All: Finds and replaces all occurrences of the text or formatting in the Find What box with the
text or formatting in the Replace With box.

Find Next: Finds and selects the next occurrence of the text or formatting specified in the Find What 
box.



List Assign Categories Command
Description:
Modifies the Address Book, the current List, or selected records to include specified categories.    The 
following options are available in the Assign Categories dialog box:

Note:    If you wish to rename or remove Categories you must use the Edit Categories command instead.

Categories: Enter the categories you wish to assign to one or more records.    Use the Categories 
button to select from the currently defined list of categories.    You can create new 
categories by just typing them into the Categories field.

Current List: Select this option if you wish to modify only the records displayed in the List View 
window, skipping all other database records.    The current list may not necessarily 
contain all database records.    It could contain a list from a previous search or a range of 
records selected by the current List View dialog settings.    Choose Entire Database if 
you want to insure that all records in the Address Book are modified.

Selections: Select this option if you wish to modifiy only the records currently selected in the List 
View window, skipping all other records.

Entire Database:
Select this option if you wish to modify the entire database, regardless of which records 
are displayed in the List View window.



List Locate Command
Description:
Search the List for the next record that matches the characters typed into the Search pop-up box.    This 
feature is automatic - simply make the List window the active window and begin typing.    The Search box
pops up, displaying the text you are typing.    Press enter to begin the search for the text in the Search box 
or Escape to quit.    The beginning characters of the current sort order field are searched.



Record Menu

The Record Menu applies to the Record Window, which displays the current record.    Use the Record 
menu to choose create, view, modify, save and delete individual records and their contents.

For more information, choose from the following commands:
New Record
Duplicate
Delete
Save
Cancel
Print record
Previous Letter
Previous Record
Next Record
Next Letter
1 Main Address
2 Phone Numbers
3 Fields
4 First Notes
5 Second Notes
6 Second Address
7 Third Address
Next Call
Time Stamp Notes
Font



Record New Record Command
Description:
Creates a new record.    Enter the new information, then select the Record Save menu item or press 
Enter.    Choose Record Cancel or press Escape to abandon your changes.



Record Duplicate Command
Description:
Duplicates the current record.    A new copy of the current record will be made with some fields blanked 
out.



Record Delete Command
Description:
Deletes the current record.    You will be asked to confirm the deletion.    This command is disabled while 
you are editing a new record.



Record Save Command
Description:
Saves the current record.    This command is disabled if you have not made any changes to the record.



Record Cancel Command
Description:
Cancels the current change(s).



Record Print record Command
Description:
Prints the contents of the current record.



Record Previous and Next Commands

Previous Letter button.
Previous Record button.
Next Record button.
Next Letter button.

Description:
Previous Record and Next Record move to the previous and next records in the Address Book, 
regardless of what character it begins with.    Previous Letter and Next Letter move to the record whose 
beginning character directly precedes or follows that of the current record.    Imagine an Address Book 
whose first 3 records are "Adams", "Brady" and "Brook".    If you are viewing "Brook", Previous Record
will move to "Brady", while Previous Letter would move to "Adams"



Record Main Address Command
Description:
The Record View - Main Address view displays the information in the current record's Name and 
Address fields.
The following options are available in the Record View - Main Address window:

Select a telephone number from the Telephone Drop down box and save the record.    This number 
becomes the Primary Telephone Number.

 Select the categories for the current record.    Remember to save the record after making any changes.    
Click here to view the Select Categories Dialog Box.



Record View - Select Categories dialog box
Description:
Choose the Categories you want to assign to the current record.    You may select more than one category.
Select OK to accept your selections, or Cancel to exit this dialog without making any changes.



Record Phone Numbers Command
Description:
The Record View - Phone Numbers window displays the information in the record's telephone number 
fields.
You may fill in the fields with telephone numbers for the current record.    Edit Telephone Types lets you 
make changes to the Telephone Types and their order.    Once the numbers are entered and you have set up
your modem, click on the button next to the number to dial the number.    METZ Phones also allows you 
to keep track of your telephone calls for the current record.    The following options are available in the 
Record View - Telephone Numbers window:

To schedule a call for the current record, select the Next button.    Click here to view the Next 
Call/Last Call Detailed Descriptions

To change the date and time of the last call made for the current record, select the Last button.    
Click here to view the Next Call/Last Call Detailed Descriptions



Next Call/Last Call Dialog Box:
Description: METZ Phones allows you to keep track of your telephone calls for the current record.    
Both the Next Call and Last Call dialog boxes work in the same way.    Each is essentially a scheduling 
dialog that allows you to select a date and time.    Although METZ Phones will not place a scheduled call 
for you automatically, you may easily review the last date and time you called the current record, and you 
may schedule calls for the future.

Options are:

Set the target time with the hour and minute arrow buttons and the AM and PM 
radio buttons.

Change the target date with the year and month buttons.

Select the Today button to return the calendar to the current date.

Select the Clear button to clear the Last or Next call value.

Select the Cancel button to exit the dialog without saving any changes.

Select the OK button to exit the dialog and save any changes.
Notes: When a Next or Last call reference exists, that reference will appear in the Telephone Numbers
window next to the Next or Last buttons.    Once a Next Call reference is set, select the Next button to 
view or reset it.    Select the View Pending Calls Command from the List Menu to display a list of 
pending calls (through today).



The Select Date dialog:
Description: Use this dialog to select a date range of calls in the List.    Click on any of the buttons for 
more information:



Record Fields Command
Description:
The Record View - Fields window displays the information in the record's user defined fields.



Record First Notes Command
Description:
The Record View - First Notes window displays the information in the record's first Notes field, a blank 
"sheet" for free-form notes.



Record Second Notes Command
Description:
The Record View - Second Notes window displays the information in the record's second Notes field, a 
blank "sheet" for free-form notes.



Record Second Address Command
Description:
The Record View - Second Address window displays the information in the record's second Address 
fields.



Record Third Address Command
Description:

The Record View - Third Address window displays the information in the record's third 
Address fields.



Record Time Stamp Notes Command
Description:
Insert the date and time into the current record's Note field.    If a Note field is not currently active, the 
first notes field will be activated and the date and time will be inserted.    The File Preferences Dialog 
allows you to choose where the Time Stamp is inserted into the notes.    The format of the Time Stamp is 
based on the Windows Control Panel International Short Time and Date formats.



Record Next Call Command
Description:
Use this command to schedule the next time you would like to call the person or company in the current 
record.    To view your pending list of calls for today, see the View Pending Callscommand.



Record Font Command
Description:
Select the Font, Font Style, and Size of the font that the Record View window will use.    Clear each of 
these items to restore the default font.



Dial Menu

From the Dial menu, you adjust your modem settings, display the dial pad, dial the primary telephone 
number, and display the area and country code dialogs.

For more information, choose from the following commands:
Modem Settings
Dial Pad
Dial Primary Number
Dialing Codes
Area Codes
Country Codes



Dial Modem Settings Command
Description:
The following options are available in the Modem Settings dialog box:
Connection Select the communications port for your modem.      If you choose the AutoConfig 

button, the port will be selected automatically.
Baud rate Select the baud rate (speed) for your modem.      If you choose the AutoConfig button, 

the baud rate will be determined automatically, however, some modems will report a 
higher baud than they actually support.    Please confirm that the baud rate matches that 
of your modem.

Telephone Select the type of telephone system you have.    Rotary dial systems use the Pulse 
setting, touch tone systems use Tone.

Initialization If you want to add advanced modem initialization strings (such as disable call waiting), 
place them here.    Otherwise, nothing needs to be entered into the Initialization field.    
An "AT" prefix is optional (METZ Phones automatically adds one if you do not).    One
way to speed up dialing is to add S11=55 here.    Some modems do not support this 
settings, symptoms include not dialing telephone numbers.    Refer to your modem 
manual for information about the S11 command.

Speaker Select the desired modem speaker state while dialing.    Phones will not attempt to 
adjust the speaker when "None" is selected.

Volume Choose the desired modem speaker volume.    This has no effect if your modem does 
not have a speaker.    This option is used only when the Speaker setting is set to "On".

Timeout Specify the number of seconds that the dialing process will wait before automatically 
hanging up the telephone.    At least 30-40 seconds are usually necessary for long 
distance dialing.

Dialing prefix Enter any prefix necessary to dial out on your telephone system such as "9,".    With this
setting, you won't need to enter the prefix for every telephone number in your database. 
This prefix is also automatically added to the telephone number when you use the 
METZ Phones Hotkey dialing feature.    Do not place an "AT" prefix in this field.    
METZ Phones will automatically add the correct "ATDT" or "ATDP" prefix when 
dialing if it is not already part of the phone number.

International prefix
Enter the number or codes (such as "011") necessary to dial international numbers .    
Like the Dialing Prefix, this value will be automatically added when dialing 
international numbers if it is not already part of the phone number.    A phone number is
considered to be an international if it contains a plus sign "+" or a left bracket "[".

Long Distance Prefix
Enter the number or codes (such as "1") necessary to dial long distance numbers .    
Like the Dialing Prefix, this value will be automatically added when dialing long 
distance if it is not already part of the phone number.    This prefix will not be added to 
an international number.

Current Country Code
Enter your current country code.    This number will be ignored when it is in a phone 
number you are dialing.    In order for Phones to detect the country code in a telephone 
number, the country code must begin with a plus sign "+" or be enclosed in square 
brackets [ ].    For example if your current country code settings is 1 (USA) and the 
telephone number to be dialed is entered as +1 (206) 641-4525, the +1 will be ignored 
when the number is dialed.

Current Area Code



Enter your current area code.    This number will be ignored when it is in a phone 
number you are dialing.    Put the area code in parenthesis (    ) when you are entering 
telephone numbers to help insure that Phones will detect it.    For example: (206) 641-
4525.

Dialing Suffix Similar to the Dialing Prefix, this number will be appended to the end of the phone 
number when dialing.

Dial Alphabetic Phone #'s
When this option is enabled, Phones will automatically convert characters to their 
corresponding dial pad numbers.    This allows you to enter alphabetic characters in the 
phone number fields.    For example, "A", "B" and "C" each are the number "2" on a 
telephone dial pad.

Automatic redial if busy
Check this option if you want METZ Phones to automatically redial the number when 
it detects a busy signal.

Retries Select the maximum number of attempts to try redialing when a busy signal is detected.
A value of zero or blank will cause the redialing to continue until you cancel it.

Pause Enter the number of seconds to wait until trying to dial again after a busy signal is 
detected.    A value of zero or blank will cause the redialing to start immediately.

AutoConfig Choose the AutoConfig button to let METZ Phones determine your Connection and 
Baud rate automatically.    

OK Save the changes.
Cancel Close the dialog without saving the changes.

Notes:
The modem settings allow you to set the dialing and long distance prefixes and current 

area and country codes.    These settings affect how a phone number is dialed.    In the actual telephone 
numbers, precede the country code with a plus sign "+" or enclose it in square brackets "[ ]" and enclose 
the area code in parenthesis "( )" to insure they will be properly detected.

Should you have some phone numbers that need to be dialed as is, regardless of the 
modem settings, place an equal "=" character at the beginning of the number.    The equal sign will be 
ignored and the number will be dialed as is.



Dial Dialing Codes Command
Description:
The Dialing Codes dialog box displays a list of the dialing codes you have defined.    The following 
options are available on this dialog:
Add Choose the Add button to create a new item.
Edit Choose the Edit button to modify the selected item.
Delete Choose the Delete button to remove the selected item.
Close Choose the Close button to close this dialog.

Notes: If you need to dial an access code or some other number when dialing from your 
database, this feature allows you to define a shortcut for entering the code in a phone 
number.    For example, if you needed to dial 123456789 when dialing some numbers, 
you could define A as the code for 123456789, then simply add the A to the phone 
numbers which require it.    When the number is dialed, the A will be replaced with 
123456789.    Be careful when choosing codes as they may be conflict with actual 
telephone numbers.    You might use a tilde ~ or $ as a prefix (i.e. ~A or $A) to the code to
help distinguish it from the phone numbers.    Dialing codes are not case sensitive.



Dial Pad Command
Description:
The Dial Pad lets you type in a telephone number and dials it automatically for you.    After entering the 
number, select the Dial button or press Enter to dial the telephone number.

Be sure that you have selected the correct options in the Modem Settings Dialog Box.



Dial Primary Number Command
Description:
Use this command to dial the Primary Telephone Number.    This command displays the Dial Dialog box.



Dial Area Codes Command
Description:
The Area Codes dialog box displays a list of the telephone area codes.    You may modify this list.    The 
following options are available on this dialog:
Add Choose the Add button to create a new item.
Delete Choose the Delete button to remove the selected item.
Close Choose the Close button to close this dialog.
Sort Alphabetically

Check the Sort Alphabetically check box to toggle the sort order of the list.
The information displayed in this dialog box is stored in the file METZPHO.COD.    If you run the METZ
Phones installation program, the file will not automatically be replaced on your hard drive unless it has 
been deleted.



Dial Country Codes Command
Description:
The Country Codes dialog box displays a list of the telephone country codes.    You may modify this list.   
The following options are available on this dialog:
Add Choose the Add button to create a new item.
Delete Choose the Delete button to remove a selected item.
Close Choose the Close button to close this dialog.
Sort Alphabetically

Check the Sort Alphabetically check box to toggle the sort order of the list    The Country 
Codes are sorted alphabetically instead of numerically since the first digit of the code 
represents a continent or area of the globe.    This order groups nations geographically.

The information displayed in this dialog box is stored in the file METZPHO.COD.    If you run the METZ
Phones installation program, the file will not automatically be replaced on your hard drive unless it has 
been deleted.



Dial Dialog Box
Description:

This dialog displays the number being dialed and the call status.    Follow the instructions as they 
appear in the Status Line.    Pickup the telephone, then choose the Hangup button after the number has 
been completely dialed.

When you use a modem to dial a phone number, the modem cannot detect when the phone has been 
answered or that you have picked up your telephone.    Because of this, you must click the Hangup or 
Close button when you want the modem to disconnect from the line.    The line may be somewhat muted 
until you do this.    The modem    will automatically disconnect based on the timeout in your modem 
settings.    Busy signals will cause the modem to automatically disconnect the line as well.    Be sure that 
you have properly configured your modem with the Modem Settings Dialog Box.

Here are the available options:
Date/Time/Call Timer

Double click on the Call Timer to reset it to zero, otherwise it will reset itself each time 
you dial.

Redial if busy When this option is checked, the number will be automatically redialed if a busy signal 
is detected.    The redial pause and number of attempts are set in the Modem Settings 
Dialog Box.

HangUp Click HangUp (or press Enter) when the dialing is completed and after you have picked
up the telephone.    The modem remains connected to the line until you click this button. 
The HangUp button becomes the Dial button after the modem is disconnected.

Dial Begins dialing the telephone number.    The Dial button becomes the HangUp button 
while dialing.

Close Close this dialog. 
Status line Displays the dialing status and appropriate messages or instructions.

Notes:
The METZ Phones modem settings allow you to set the dialing and long distance 

prefixes and current area code.    These settings affect how a phone number is dialed.    Should you have 
some phone numbers that need to be dialed as is, regardless of the dialing prefix, long distance code, area 
code and dialing suffix values, place a "=" character at the beginning of the number.    The equal sign will 
be ignored and the number will be dialed as is.



Window Menu

From the Window menu, you can customize the appearance of METZ Phones List and Record Windows.

For more information, choose from the following commands:
Tile Horizontal
Tile Vertical
Split



Window Tile Horizontal Command
Description:
This option will cause the List and Record Windows to be arranged horizontally, with the List Window 
above the Record Window.



Window Tile Vertical Command
Description:
This option will cause the List and Record Windows to be arranged vertically, with the List Window to 
the left of the Record Window.



Window Split Command
Description:
When the Split item is checked, both the List and Record windows will be visible.    You can use the 
Window menu items 1 and 2 to switch between the List and Record windows.



Help Menu

From the Help menu, you can view various help information.

For more information, choose from the following commands:
Contents
Trouble Shooting
Search for Help on
How to Use Help
About METZ Phones

Note:    If you have METZ Task Manager, the award winning replacement for the Windows Task List, 
installed on your system, there will be a System Status item on the Help Menu and a corresponding 
button on the Tool Bar.    See the METZ Task Manager documentation for help with the System Status 
Command.



Help Contents Command
Description:
Displays the Contents section of this Help file.



Help Trouble Shooting Command
Description:
Displays the Trouble Shooting section of this Help file.



Help Search for Help on Command
Description:
Displays the Help search dialog.



Help How to Use Help Command
Description:
Displays the Help file for the Windows Help System.



Help About Command
Description:
Displays version and copyright information for METZ Phones.



System Status Command
Description:
The System Status button and menu item appear if you have METZ Task Manager, the replacement for 
the Windows Task List, installed on your system.    This command displays a detailed description of 
system information.

Memory The Memory box displays information about available memory in your system.
Total Free Memory

Displays the total amount of free memory on your system, including conventional, 
extended, and the windows swap file.

Free Graphics Resources
Displays the free graphics resources on your system.

Free User Resources
Displays the free user resources on your system.

Drive The Drive box displays the volume label, the type of disk drive, the total capacity of 
the disk drive, the amount of free disk space, and percentage of free disk space free.

Drives List Box Use the Drives list box to choose the drive for which you want to display 
information.      

General The System box displays a variety of general information about your system, 
including:

Date and Time The system date and time.
MS-DOS Version The version of MS-DOS which is running on the system.
Windows Version The version of Windows which is running on the system.
Mode Indicates whether Windows is running in Real, Standard, or 386 Enhanced Mode.
CPU The CPU type (e.g., 8088, 8086, 80286, 80386, or 80486).
Display Type The type of video display on the system (e.g., CGA, EGA, VGA).
Display Width The total width of the display in pixels.
Display Height The total height of the display in pixels.
Mouse Indicates what type of mouse is installed on the system, if any.
Network Indicates the type of network the system is connected to, if any.
WIN.INI Button

Choose the WIN.INI button to edit the WIN.INI file.    The WIN.INI file appears, 
loaded into the default application.    The WIN.INI file contains information about 
preferences which have been set in Windows and in Windows applications.

SYSTEM.INI Button
Choose the SYSTEM.INI button to edit the SYSTEM.INI file.    The SYSTEM.INI 
file appears, loaded into Windows Notepad.    The SYSTEM.INI file contains 
information about your Windows system settings, including your screen, printer, and
keyboard drivers.

METZPHO.INI Button
Choose the METZPHO.INI button to edit the METZPHO.INI file.    The 
METZPHO.INI file appears, loaded into the default application.    The 
METZPHO.INI file contains information about how you have installed METZ 
Phones, as well as the preferences you have chosen.

AUTOEXEC.BAT Button
Choose the AUTOEXEC.BAT button to edit your AUTOEXEC.BAT file.    The 
AUTOEXEC.BAT file appears, loaded into the default application.    The 
AUTOEXEC.BAT file contains commands that run every time you start MS-DOS 
on your system.

CONFIG.SYS Button



Choose the CONFIG.SYS button to edit your CONFIG.SYS file.    The 
CONFIG.SYS file appears, loaded into the default application.    The CONFIG.SYS 
file sets up your system configuration whenever you start MS-DOS.

Close Button Choose the Close button when you are finished looking at the System Status dialog.
Print Button Choose the Print button if you want to print the contents of the System Status dialog.

Make sure your printer is connected and on-line.



Programming with METZ Phones

Using DDE
METZ Phones DDE interface provides a powerful way for Windows applications to access the data you 
have stored in a METZ Phones database.    For example, you may want to extract data for a mail merge or 
to create a custom report using a word processor.    

The METZMERG.DOC included with METZ Phones is a sample mail merge macro for Word including 
the WordBasic source.    Additional products will be available for more flexibility and to support popular 
word processors.

The command documentation uses the following syntax:
Values in {} are optional, do not include the {}.The entire command needs to be enclosed in square 

brackets [].    Commands and most parameters must be in uppercase, the SET command allows mixed 
case for the data field.

We are following the Microsoft C++ Database functions as closely as possible.    These functions are very 
similar to the Visual Basic database functions.    Please let us know what other types of commands you 
would like to have added, and send us any macros you have created so we can start building a library of 
examples.

For more information, choose from the following topics (a version in square brackets indicates the earliest
version of Phones supporting the DDE command):

Managing a DDE Connection
DDE Command: Type:

ADDNEW DDEEXECUTE
CANCEL DDEEXECUTE
CLOSE DDEEXECUTE
DELETE DDEEXECUTE
DESELECTALL DDEEXECUTE
DIAL DDEEXECUTE
DIALSELECTION    [5.51] DDEEXECUTE



EDIT DDEEXECUTE
EXIT DDEEXECUTE
FIND DDEEXECUTE
FORMATFILTER    [5.51] DDEREQUEST
FORMATLAYOUT DDEREQUEST
GETCATEGORYCOUNT DDEREQUEST
GETCATEGORYTEXT DDEREQUEST
GETCOUNT DDEREQUEST
GETDATABASENAME DDEREQUEST
GETFIELDCOUNT DDEREQUEST
GETFIELDTEXT DDEREQUEST
GETFILTER    [5.51] DDEREQUEST
GETFILTERCOUNT    [5.51] DDEREQUEST
GETFILTERLAYOUT    [5.51] DDEREQUEST
GETPHONECOUNT DDEREQUEST
GETPHONETEXT DDEREQUEST
GETVERSION    [5.51] DDEREQUEST
HANGUP DDEEXECUTE
LISTVIEWALL DDEEXECUTE
LISTVIEWCATEGORY DDEEXECUTE
MOVE DDEEXECUTE
MOVEFIRST DDEEXECUTE
MOVELAST DDEEXECUTE
MOVENEXT DDEEXECUTE
MOVEPREV DDEEXECUTE
OPEN DDEEXECUTE
SELECTALL DDEEXECUTE
SET DDEEXECUTE
UPDATE DDEEXECUTE



Managing a DDE Connection
Description:
To establish a DDE connection with METZ Phones, use the application string METZPHO, and the topic 
name METZPHO.

Example:
Establish a DDE Connection with METZ Phones from Microsoft Word:
channel=DDEInitiate("METZPHO", "METZPHO")

Terminate a DDE connection with Phones.
DDETerminate channel

Establishing a Unique DDE Connection:
Should you wish to establish an exclusive session with Phones, launch it using the "-T" parameter to 
defined a unique DDE conversation topic name:
Shell "METZPHO.EXE example.db -Tyourtopic" or Shell "METZPHO.EXE -Tyourtopic"
Then use "yourtopic" as the second parameter of the DDEInitiate command.    Only the copy of Phones 
you ran with the -T option will respond to the request.    The "-T" must be the last parameter of the 
command line, "yourtopic" can be replaced with text of your choice.



ADDNEW Command
Description:
Instructs Phones to prepare for adding a new record to the current database.    Use the SET command to 
modify the record contents.    Use the CANCEL command to abandon a new record, and the UPDATE 
command to save a new record.

Example:
DDEExecute "[ADDNEW()]"



CANCEL Command
Description:
Instructs Phones to cancel a record prepared for editing (EDIT) or addition (ADDNEW).

Example:
DDEExecute "[CANCEL()]"



CLOSE Command
Description:
Instructs Phones to close the current database.

Example:
DDEExecute "[CLOSE()]"



DELETE Command
Description:
Instructs Phones to delete the current database record.    Use the MOVE commands to position the current 
record.    After deleting a record, the current record position is undefined.

Example:
DDEExecute "[DELETE()]"



DESELECTALL Command
Description:
Instructs Phones to deselect any selected records in the List Window.

Example:
DDEExecute "[DESELECTALL()]"



DIAL Command
Description:
Instructs Phones to dial a telephone number.    No number causes the dialing dialog to appear, prompting 
the user for a telephone number.

Example:
DDEExecute "[DIAL(206-641-4525)]" or "[DIAL()]"



DIALSELECTION Command
Description:
Instructs Phones to dial the currently selected text in the application, just as if the user pressed the dial 
hotkey.

Example:
DDEExecute "[DIALSELECTION()]"



EDIT Command
Description:
Instructs Phones to lock the current record and allow changes.    The record cannot be changed while 
another user or DDE process is editing the record.    Use the SET command to modify the record contents. 
Use the UPDATE command to save changes, use the CANCEL command to abandon any changes.

Example:
DDEExecute "[EDIT()]"



EXIT Command
Description:
Instructs Phones to close the current database if any, and close itself after the DDE conversation is 
completed.

Example:
DDEExecute "[EXIT()]"



FIND Command
Description:
Performs a text search of records based on specified criteria.

FIND(search text, case sensitive, whole word, search field, list option, keep selections, create list, begins 
with)
search text - specify the text to search for (required).
case sensitive - Y if case sensitive, N if not (default is N).
whole word - Y if whole word searching, N if not (default is N).
search field - What to search - use the same text found in the Find dialogs search dropdown.    (i.e. 

Whole Record or Notes)    (default is Whole Record)
list option - C to search current list, S to search selections, D to search entire database (Default is C).
keep selections - Y to include the currently selected records in the results, N if not (default is N).
create list - Y to create a new list with the search results, N if not (default is N).
begins with - Y to search only for fields that begin with the search text, N if not (default is N).

Please review the online help for the Phones Find Dialog for further details, as the above options simply 
mirror the options on the Find Dialog.
If the FIND command creates a new list, it is necessary to issue one of the MOVE commands to 
reposition the DDE record cursor.

Example:
DDEExecute$(channel, "[FIND(xyz,N,N,Whole Record,D,N,Y,N)]")



FORMATFILTER Command [5.51]
Description:
Instructs Phones to use an existing filter to retrieve formatted information from the current record. The 
filter layouts are created in the Edit Hotkey & Clipboard Layouts dialog.    The filter name is passed as the
parameter.    The filter name is case insensitive.

Example:
DDERequest$(channel, "[FORMATFILTER(Letter Head)]")



FORMATLAYOUT Command
Description:
Instructs Phones to filter the layout, replacing fields in the layout with values from the current record. The
layout can be created in the Edit Hotkey & Clipboard Layouts dialog, then copied through the clipboard 
into the macro.    The layout can include text.    Database fields are enclosed in square brackets [] and 
replaced with the equivalent fields from the current record. The layout can include one or more fields.

Example:
DDERequest$(channel, "[FORMATLAYOUT([FIRST] [LAST])]")



GETCATEGORYCOUNT Command
Description:
Returns the number of categories defined for the current database.

Example:
DDERequest$(channel, "[GETCATEGORYCOUNT()]")



GETCATEGORYTEXT Command
Description:
Returns the actual text of a category.    The category number is passed as a parameter, where zero is the 
first category item.

Example:
DDERequest$(channel, "[GETCATEGORYTEXT(0)]")



GETCOUNT Command
Description:
Returns the count of records in the list window.    Optional parameters are ALL, LIST, or SELECTION.    
LIST is the default if none are specified.    ALL returns the number of records in the entire database, LIST 
returns the number of records currently in the List Window, and SELECTION returns the number of 
records currently selected in the List Window.

Example:
DDERequest$(channel, "[GETCOUNT(LIST)]") or "[GETCOUNT(SELECTION)]" or 
"[GETCOUNT(ALL)]"



GETDATABASENAME Command
Description:
Returns the name of the currently open database.    Returns an empty string if no database is currently 
open.

Example:
DDERequest$(channel, "[GETDATABASENAME()]")



GETFIELDCOUNT Command
Description:
Returns the number of user defined fields in the current database.

Example:
DDERequest$(channel, "[GETFIELDCOUNT()]")



GETFIELDTEXT Command
Description:
Returns the text of a user defined field description.    The field number is passed as a parameter, where 
zero is the first field item.

Example:
DDERequest$(channel, "[GETFIELDTEXT(0)]")



GETFILTER Command [5.51]
Description:
Returns the filter name for the given position.    Use GETFILTERCOUNT to determine how many filters 
are available.    Filters are defined in the Phones Edit Hotkey & Clipboard Layouts dialog.

Example:
DDERequest$(channel, "[GETFILTER(2)]")



GETFILTERCOUNT Command [5.51]
Description:
Returns the number of filters currently available.    Filters are defined in the Phones Edit Hotkey & 
Clipboard Layouts dialog.

Example:
DDERequest$(channel, "[GETFILTERCOUNT()]")



GETFILTERLAYOUT Command [5.51]
Description:
Returns the contents of the filter.    The contents can include database fields and text.    The result can be 
modified and/or passed to the FORMATFILTER command.    Filters are defined in the Phones Edit 
Hotkey & Clipboard Layouts dialog.

Example:
DDERequest$(channel, "[GETFILTERLAYOUT(Letter Head)]")



GETPHONECOUNT Command
Description:
Returns the number of user defined phone fields in the current database.

Example:
DDERequest$(channel, "[GETPHONECOUNT()]")



GETPHONETEXT Command
Description:
Returns the text of a telephone field description.    The field number is passed as a parameter, where zero 
is the first field item.

Example:
DDERequest$(channel, "[GETPHONETEXT(0)]")



GETVERSION Command [5.51]
Description:
Returns the current version number of Phones.    Version 5.51 is returned as 551.

Example:
DDERequest$(channel, "[GETVERSION()]")



HANGUP Command
Description:
Instructs Phones to hangup the telephone and close    the dialing dialog.    This command is obsolete, but 
available for backward compatibility.

Example:
DDEExecute "[HANGUP()]"



LISTVIEWALL Command
Description:
Instructs Phones to display the entire list based on a sort field.    The first parameter is the sort field, the 
second parameter (optional) is the sort order.
Valid sort fields are:
LASTNAME, COMPANY, TITLE, COUNTRY, ZIP, NEXTCALL, LASTCALL, or MODIFIED (record 
modification date).
Use A for an ascending sort order, D for descending.    If no sort order is specified, ascending is the 
default.

Example:
DDEExecute "[LISTVIEWALL(COMPANY, D)]"



LISTVIEWCATEGORY Command
Description:
Instructs Phones to display the list by category.    The first parameter is the sort field, followed by one or 
more categories (comma separated).    If the second parameter is blank, then the default action will be to 
display all categories.
Valid sort fields are:
LASTNAME, COMPANY, TITLE, COUNTRY, ZIP, NEXTCALL, LASTCALL, or MODIFIED (record 
modification date).

Example:
DDEExecute "[LISTVIEWCATEGORY(COMPANY,CATEGORY1,CATEGORY2)]"



MOVE Command
Description:
Positions the current record forward or backward the number of rows.    Positive values move forward in 
the list, negative move backward toward the top of the list.    Use MOVEFIRST or MOVELAST to 
establish the initial record position.

Example:
DDEExecute "[MOVE(4)]" or "[MOVE(-5)]"



MOVEFIRST Command
Description:
Makes the first record in the Phones list Window the current record.    Use TRUE to make the first 
selected record the current record.

Example:
DDEExecute "[MOVEFIRST()]" or "[MOVEFIRST(TRUE)]"



MOVELAST Command
Description:
Makes the last record in the Phones list Window the current record.    Use TRUE to make the last selected 
record the current record.

Example:
DDEExecute "[MOVELAST()]" or "[MOVELAST(TRUE)]"



MOVENEXT Command
Description:
Makes the next record in the Phones list Window the current record.    Use TRUE to make the next 
selected record the current record.

Example:
DDEExecute "[MOVENEXT()]" or "[MOVENEXT(TRUE)]"



MOVEPREV Command
Description:
Makes the previous record in the Phones list Window the current record.    Use TRUE to make the 
previous selected record the current record.

Example:
DDEExecute "[MOVEPREV()]" or "[MOVEPREV(TRUE)]"



OPEN Command
Description:
Instructs Phones to open a specific database.

Example:
DDEExecute "[OPEN(C:\WINDOWS\METZPHO.DB)]"



SELECTALL Command
Description:
Instructs Phones to select all records displayed in the List Window.

Example:
DDEExecute "[SELECTALL()]"



SET Command
Description:
Use this command to set fields in a record prepared by the ADDNEW or EDIT command.    The first 
parameter is the field to set, the second is the value.    Valid fields are any fields listed in the Export or 
Import database fields listboxes.    The data will be parsed and handled in the same manner as the 
import/export process.

Example:
DDEExecute "[SET(COMPANY,METZ Software)]"
DDEExecute "[SET(ADDRESS,P.O. Box 6699)]"



UDPATE Command
Description:
Use this command after the ADDNEW or EDIT command to complete the operation.    The current record
will be saved.

Example:
DDEExecute "[UPDATE()]"



Trouble Shooting and Error Messages
If, after carefully reading through the following suggestions, you require technical assistance, contact 
METZ Software for Technical Support.    The telephone number and a fax form for you to print and fill 
out are at the bottom of this topic.

General:

Continuous Labels do not page correctly:
The printer driver controls the length of a page - which usually contains one or more labels.    Sometimes 
the printer is set to a page length that does not match the break for continuous feed labels.    From the 
METZ Phones File menu, choose Printer Setup, then select or create a page size which matches your 
labels.    Please refer to the on-line help or documentation for your particular printer for instructions.

Printing:
If you have trouble printing - especially labels, make sure you have the correct printer driver installed in 
the control panel.    For example, if you have the HP LaserJet IIP, use the HP LaserJet IIP printer driver, 
not the generic HP LaserJet driver.    Refer to your printer manual for the information on which drivers are
supported by your printer. 

The List window is empty:
The List View dialog determines which records are displayed in the List window, what information is 
displayed, and what the order is.    It is possible that some of the fields are blank or you have selected a 
list which is currently empty (like Calls).    Make sure the settings are correct using the List View 
command.

Error Messages (alphabetical)  :  

"{file} does not exist.    Would you like to create it now?"
METZ Phones will accept a database name as a command line parameter when it is run or will use the 
default database set in the Preferences dialog box.    If either of these are specified when Phones is run, 
but the database does not exist, you will be asked if you want to create it.    If you are attempting to run a 
database from a network drive and this message occurs, check your network connection to make sure you 
have access to the network drive.

"A secondary index is corrupted, click OK then press CTRL+R to rebuild the database indexes."
An index can become corrupted or out of date if a user reboots or turns of    their machine while changing 
a phone book.    Press CTRL+R from the main Phones window to rebuild the indexes for any Phones 
database.

"A secondary index is out of date, click OK then press CTRL+R to rebuild the database indexes."
An index can become corrupted or out of date if a user reboots or turns of    their machine while changing 
a phone book.    Press CTRL+R from the main Phones window to rebuild the indexes for any Phones 
database.

"An error occurred while writing file!    Check your disk space."
This message usually indicates that there is insufficient free disk space available on the disk drive. 

"Cannot delete database, the database is currently in use by another user."



In a network environment, multiple users can access the same database.    On an individual PC, multiple 
copies of Phones can access the same database.    In either case, if the database is in use by another user or
copy of Phones, the database cannot be deleted.    Have the other users close the database, or close the 
additional copies of Phones.

"Cannot dial, check your modem settings."
Make sure you have correctly set the com port and baud rate in the Modem Settings dialog box

"Cannot find database sub table.    If you moved the main database file to a new location, you need 
to move it's subdirectory as well."
Use the File Save As menu item to copy a database to a new location.    Use the File Delete menu item to 
delete the old database if you wish.    The database also includes a subdirectory by the same name 
containing additional tables and indexes which also need to be copied with the main database.    The File 
Save As menu item does this automatically.

"Cannot lock record."
Because multiple users can access and share the same database, only one user can make changes to a 
record at a time.    The record is locked when you edit it, preventing changes by another user.    When you 
select Save or Cancel, the record is unlocked. 

"Cannot save a blank record."
If the important fields of a record are blank - like the Name and Company, the record cannot be saved.

"Cannot share database - is SHARE.EXE loaded and the Paradox control file directory correct 
(Preferences Dialog)?"
The Borland Paradox Engine used by METZ Phones requires that you have SHARE.EXE installed.    
Normally, the METZ Phones installation program will do this for you.    Please refer to your DOS User's 
Guide for information on installing SHARE.      Windows for Workgroups automatically installs SHARE 
support.    A virtual device driver called VSHARE.386 can be downloaded from CompuServe as an 
alternative to SHARE.EXE.

"Cannot validate database."
The database appears to be invalid or was not created by METZ Phones.    Make sure you are opening a 
database you created, not one of the .DB files in the database subdirectory.    (I.E. creating METZPHO.DB
also creates a METZPHO subdirectory with additional .DB files.)

"Caution: Deleting this telephone type will also delete all phone numbers of this type in the 
database."
When you delete a telephone type, all the telephone numbers of that type will be deleted.    Other records 
may contain telephone numbers of the type.    Make sure this is what you want to do before deleting a 
telephone type.    You can use the Change option to rename a telephone type.

"Caution: Deleting this field type will also delete all fields of this type in the database."
When you delete a field type, all information for fields of that type will be deleted.    Other records may 
contain field information for the type.    Make sure this is what you want to do before deleting a field type.
You can use the Change option to rename a field type.

"Could not open the communications port, please check your modem settings."
METZ Phones could not open the com port.    It may be in use by another application (such as a FAX 
program) or be incorrectly configured.    Check the settings in the Modem Settings dialog box.



"Could not send the modem commands, check your modem settings."
The optional modem settings may be incorrect.    Check the settings in the Modem Settings dialog box.

"Could not start printing, check your Print Manager."
The Print Manager returned an error during an attempt to print.    Check your Control Panel printer 
settings and try printing from another Windows application.    If the other application prints correctly, 
please contact METZ Software.    You can also try restarting Windows or closing other applications first.

"Insufficient Paradox swap buffer space to complete operation.    Restart Windows and try again."
The Paradox engine does not have enough memory available for it's internal use.    Restart Windows and 
try again.    You can run multiple copies of Phones on your individual computer, but the Paradox engine 
will limit the number of copies depending on available memory.    Typically, you can run up to three 
copies of Phones at a time.    If you wish to run more copies, please contact Technical Support.

"Insufficient disk space!"
There is not enough free disk space available.    Free up some disk space and try again.

"Insufficient memory!"
Usually too many applications are running if you encounter this error message.    Close some applications 
and try again.    If the problem persists, try restarting Windows.

"Invalid printer or no printer selected, check your printer setup."
The Print Manager returned an error indicating that no printer is installed or selected.    Check your 
Control Panel printer settings.

"Multiple Paradox Control files exist (PDOXUSRS.NET).    Check your Phones Configuration 
Paradox control file directory."
The PDOXUSRS.NET file controls the use of Borland Paradox databases by multiple users or 
applications.    This file also exists for single users.    The METZ Phones preferences dialog allows you to 
indicate the directory for this file.
You will see this error message if the .NET file can be found in more than one location or you have old 
PARADOX.LCK and PDOXUSRS.LCK files that were not deleted when an application using the 
Paradox was closed or crashed.    Often deleting the old .NET or .LCK files will correct the problem.    Be 
careful when deleting these files in a network environment (make sure no other users have the database 
open).

"No records were found for the selected call date range.    Use the List View command to select the 
date range."
No records were found that matched the dates you specified in the List View dialog or for the pending call
list.    Use the List View dialog to choose a different range of calls or to select the kind of records you 
want displayed in the List window.

"Optional Modem Initialization command must not begin with 'AT'.    The 'AT' will be added 
automatically."
The optional modem settings should not begin with 'AT'.    This will automatically be added by METZ 
Phones.

"Optional Modem Initialization failed, check your modem manual."
The optional modem settings may be incorrect.    Check the settings in the Modem Settings dialog box.

"Paradox error, please contact METZ Software."



The error message will include two numbers, please write down the numbers and what you were doing, 
then contact METZ Software technical support for assistance.

"Printer error, check your Print Manager."
The Print Manager returned a printer error.    Check your Control Panel printer settings and your printer.

"The database cannot be opened.    If it is shared on a network, your Paradox control file directory 
may be incorrect.    Check your File Preferences settings."
The File Preferences dialog help explains how to set up the Paradox control file directory setting.    If you 
are not on a network, then close Phones, delete the PDOXUSRS.NET and any PARADOX.LCK and 
PDOXUSRS.LCK files, then try again.    These files can become corrupted if your machine crashes or is 
turned off while Phones is running.    Usually, they will correct themselves.

"The database is in use by another user and cannot be modified at this moment, try again later."
Database operations such as Delete and Save As cannot be completed while another user is making 
changes to the database. 

"The database was created by a newer version of METZ Phones!    Contact METZ Software for 
upgrade information."
You have an older version of METZ Phones than which created the database.    In this case, contact us for 
update or upgrade information. 

"The drive or directory cannot be accessed."
Make sure the drive is valid and currently available.    Otherwise, make sure the directory is correct.    
Contact your network administrator for further assistance.

"The network drive or path cannot be accessed.    Make sure this user or workstation has access 
privileges and check the File Preferences Dialog Paradox control file directory setting."
This error indicates that the workstation or user does not have read/write privileges to the network drive 
and/or directory.    Check the Paradox control file directory setting, making sure the drive is valid and 
currently available.    Otherwise, make sure the directory is correct.    Contact your network administrator 
for further assistance.

"The Paradox control file directory setting is invalid.    Please check the File Preferences dialog 
settings."
This error indicates that the workstation or user does not have read/write privileges to the network drive 
and/or directory.    Check the Paradox control file directory setting, making sure the drive is valid and 
currently available.    Otherwise, make sure the directory is correct.    Contact your network administrator 
for further assistance.

"The primary index is out of date, click OK then press CTRL+R to rebuild the database indexes."
An index can become corrupted or out of date if a user reboots or turns of    their machine while changing 
a phone book.    Press CTRL+R from the main Phones window to rebuild the indexes for any Phones 
database.

"The primary index is corrupted, click OK then press CTRL+R to rebuild the database indexes."
An index can become corrupted or out of date if a user reboots or turns of    their machine while changing 
a phone book.    Press CTRL+R from the main Phones window to rebuild the indexes for any Phones 
database.

"The record is currently locked by: {name}"



Because multiple users can access and share the same database, only one user can make changes to a 
record at a time.    The record is locked when you edit it, preventing changes by another user.    When you 
select Save or Cancel, the record is unlocked.    The name of the user as they have entered it in their 
Phones Preferences dialog box will be displayed . 

"The starting column is greater than the number of columns for the label."
You have specified a starting column which is outside the size of the currently selected label. 

"The starting row is greater than the number of rows for the label."
You have specified a starting row which is outside the size of the currently selected label. 

"Too many open tables, cannot open another."
Most likely there are too many copies of METZ Phones currently running.    Close one or more copies and
try again.

"The file is not a valid METZ Phones database!"
The file you are attempting to access does not appear to be the main .DB file created by METZ Phones.    
Make sure you are not attempting to open one of the .DB files in the database subdirectory.    I.E. if you 
created a METZPHO.DB, there will be a directory called METZPHO with additional .DB files in it.    
These are not the files you should try to open.

"Unable to delete file!    It may be in use by another application."
Database operations such as Delete and Save As cannot be completed while another user is making 
changes to the database. 

"Unable to initialize Paradox Engine."
This error is usually caused by an old copy of PXENGWIN.DLL existing on your system.    Locate all the 
old copies of this file and delete them or replace the old copies with the PXENGWIN.DLL shipped with 
METZ Phones.

"Your TEMP drive %c: does not have sufficient free space available to import the file."
When importing files, sometimes space on your temporary drive is used while importing the data.    If this
message appears, you either need to free up some disk space on the temporary drive or assign a drive with
more free space as temporary drive.    The temp drive is assigned in your AUTOEXEC.BAT file as "SET 
TEMP={drive}:\".

Technical Support:

Please use the Technical Support FAX FORM if possible or contact us electronically
on CompuServe or America Online.    You may contact METZ Software for Technical 
Support at:

METZ Software Phone: 206-641-4525
PO Box 6699 FAX: 206-644-6026
Bellevue, WA    98008-0699 BBS: 206-644-3663

CompuServe: 75300,1627
Internet: 75300,1627@compuserve.com
America Online: METZSoft
Genie: A.METZ





METZ Software Technical Support Fax Form
You may use this form to fax us your questions or comments.

METZ Software, Inc.
PO Box 6699
Bellevue, WA    98008-0699
U.S.A.

Internet: 75300,1627@compuserve.com

Voice:
FAX:
BBS:
CompuServe:
America Online:
Genie:

206 641-4525
206 644-6026
206 644-3663
75300,1627
METZSoft
A.METZ

Your Name: _________________________________________________
Company: _________________________________________________
Address: _________________________________________________
City, State, Zip: _________________________________________________
Phone: _________________________________________________
Fax: _________________________________________________

Product Name: _____________________________ Version: ____________
Product Serial Number:_____________________________
Windows Version:      [ ] 3.1        [ ] 95        [ ] WFW        [ ] NT        [ ] OS/2      [ ] Other ____
DOS Version: _________________________________________________
Network: _________________________________________________

Question/Description of problem:

What other applications are running?

Additional suggestions, comments:



METZ Software Order Form
METZ Software, Inc.
PO Box 6699
Bellevue, WA    98008-0699    USA

Sales
International
Support
FAX:
BBS:

800-447-1712
206-641-4525
206-641-4525
206-644-6026
206-644-3663

Quantity and site license pricing available for all METZ products - call for details.    For credit card orders, you may 
send this information electronically to METZ Software on CompuServe at 75300,1627 or America Online at 
METZSoft.    All prices are subject to change.    Registered users are eligible for special upgrade pricing.

            PRODUCT QUANTITY PRICE

TOTAL

METZ Phones (SRP $89) _______      x     $49 = ________

METZ Dialer (SRP $29) _______      x     $15 = ________

METZ Task Manager (SRP $49) _______      x     $39 = ________

METZ Scheduler (SRP $39) _______      x     $29 = ________

METZ Corporate Screen Saver (SRP $39) _______      x     $29 = ________

METZ Lock (SRP $49) _______      x     $39 = ________

Harcom-Access Control Software with METZ Lock _______      x     $59 = ________

METZ File F/X & Desktop Navigator (SRP $49) _______      x     $30 = ________

METZ Time (SRP $29) _______      x     $15 = ________

METZ Widget & METZ FreeMem (SRP $29) _______      x     $10 = ________

METZ Software Evaluation Disk _______      x     $    5 = ________
            (includes METZ FreeMem)

Add shipping and handling charge: (USA, Canada, Mexico $5, International $10, plus $1 for each additional 
item).

Shipping: = ________

Subtotal: = ________

                  Washington state residents add 8.2% sales tax: Tax: = ________

Payable in US Funds only. Total: = ________

Please Specify diskette format:            _____    5.25        or        _____    3.5

Name: _______________________________________________________________

Company: _______________________________________________________________

Address: _______________________________________________________________

_______________________________________________________________

Phone:    ___________________________        Fax:    _____________________________

[      ]    Check Enclosed [      ]    Bill my credit card      (    Visa,    MC    or    American Express    )

Card No.:    ___________________________________________    Exp. Date:    __________

Name on Card:    __________________________________________________________

Signature:    ______________________________________________________________
Please send us your comments and/or suggestions.






